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1 Introduction

1.1 Intention

The aim of xloops is to calculate one-particle irreducible Feynman diagrams with one or two
closed loops for arbitrary processes in the Standard model of particles and related theories.
Up to now this aim is realized for all one-loop diagrams with at most three external lines
and for two-loop diagrams with two external lines.

The results can be returned both algebraically and numerically. All necessary tensor in-
tegrals are treated for arbitrary masses and momenta. Those two-loop two-point functions
for which no analytic result is known are integrated numerically by xloops.

The calculations are performed in Maple V – a language for symbolic computations
[1, 2]. Numerical integrations are done using VEGAS – a procedure for adaptive Monte
Carlo integration [3, 4]. For convenient input xloops has an Xwindows interface based on
Tcl/Tk [5].

The package consists of the following parts:

⊲ Input via Xwindows interface:
In a window the user selects the topology which shall be calculated. A Feynman
diagram pops up in which the particle names have to be inserted.

⊲ Processing with Maple:
The selected diagram is evaluated. The necessary steps for reducing the numerator
(SU(N) algebra, Dirac matrices) are performed. The result is expressed in terms of
one- and two-loop integrals.

⊲ Evaluation of one-loop integrals:
One-loop one-, two- and three-point integrals are calculated analytically or numeri-
cally to any tensor rank using Maple. This part was already released separately [6,7].

⊲ Evaluation of two-loop integrals:
All two-loop two-point topologies including tensor integrals are supported by the
Maple routines. For those topologies where no analytic result is known, xloops creates
either an analytic two-fold integral representation or integrates numerically with the
help of VEGAS using C++ [8]. A parallelized implementation of the VEGAS algorithm
invented by R. Kreckel [9, 10] is part of this distribution.

The other topologies can be calculated analytically or numerically like one-loop
integrals.

In the second chapter we briefly denote how to install and start the program. Chapter
three gives several examples for quick and easy usage. A more detailed description of the
user-interface can be found in chapter four of this manual.
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1.2 Copyright

The copyright of this program package is owned by the Johannes Gutenberg-Universität
Mainz, Germany.

xloops is “cite-ware”. That means that you can freely use and redistribute it, but you
have to cite xloops if you publish any results that you achieved with the help of it.

Any further program development which intends to use the name xloops or the incor-
poration of xloops or a part of the xloops code into any other program needs the permission
of the authors.

With the receipt of xloops the customer accepts that he uses the program entirely on
his own risk. Neither the authors nor the distributors of xloops are liable for any loss or
damage as a result of any use which is made of this program.

1.3 Comments and bug reports

xloops is still under development. So if you have questions, comments or if you have found
any bug – please don’t hesitate to contact

xloops@thep.physik.uni-mainz.de

or one of the authors.
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2.1 Requirements

xloops can be used on any computer where Maple V is working. If Maple is not yet installed
on your computer system you have to do that first. For numerical integration of two-loop
integrals a compiler for C++ is necessary. The Xwindows interface needs Tcl/Tk and is
at present only available for Unix. On other platforms or if Tcl/Tk is not installed the
Xwindows interface will not work. In this case you can use the Maple part directly (cf.
sect. 2.4 and 2.5). The Maple part covers most features of the xloops package but the input
may be found not as user-friendly as if the interface is used.

2.2 Installation

The distribution of the xloops package is accessible via WWW at

http://wwwthep.physik.uni-mainz.de/~xloops/

It consists of one packed (tared, gzipped) file

xloops-1.0.tgz

This file contains all files needed for xloops. To install the package unpack xloops-1.0.tgz:

tar -xzvf xloops-1.0.tgz

xloops then automatically creates a subdirectory of the current directory which is called
xloops. The package is then deposited there. In addition there will occur several subdi-
rectories of xloops. A complete list of all files in the distribution is given in appendix B.4.
Moreover, there exists an additional (tared, gzipped) file

xloops-lib.tgz

in the same directory as xloops-1.0.tgz which contains a library of one-loop diagrams
(cf. sect. 4.5). For convenience one should unpack this file in the same directory where
xloops-1.0.tgz was unpacked before. xloops will read from this library whenever a one-
or two-loop integral has to be evaluated. If this library is missing xloops will create the
necessary files automatically, but this will usually take some time. If you have the bash
shell type

cd xloops/

configure
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This will settle the configuration of the Xwindows interface. configure will request

⊲ the release of Maple V (1, 2, 3 or 4) you are using. There were subtle changes from
release 2 to 3 in handling local and global variables, therefore it is important to
select the correct option. Since we tested only Maple V release 1 and 3, for release 2
and 4 configure internally does the following replacement:

release 2: use the same files as for release 1
release 4: use the same files as for release 3 (with some patches)

which is expected to be consistent.

⊲ the WWW browser which should be used for the on-line html version of this manual.
The name of the executable (cf. netscape, mosaic, . . . ) must be inserted.

⊲ the character encoding of your terminal (Isolatin 1 or standard ascii).

⊲ whether multiprocessing is enabled. This question is necessary to choose between
normal VEGAS or the parallelized version of VEGAS running on multiprocessor com-
puters only. If multiprocessing is enabled the number of processors is requested.

⊲ the platform. Several frequently used systems (Linux, Digital Unix, SUN Solaris, IBM
AIX) are distinguished from other Unix to install the right Makefile for the numerical
integration.

⊲ whether a library of one-loop integrals should be build. It can take a lot of time
(up to an hour) on slower computers to build the whole library. Therefore it is
recommended not to do that, but to load a pre-built library xloops-lib.tgz from
our WWW server instead.

After that several checks are performed. First an embarassing bug occuring in Maple
releases up to release 3 is tested: If a file is read in a procedure, no output of the procedure
will appear. Therefore we have written a little workaround for this bug, which can be
installed by the user.

configure continues with a test run of the Makefile which is needed for numerical
integrations. This Makefile depends on the platform. The run will take some time.

Finally you are asked to agree that automatically a mail is sent to the developer team
of the xloops package. This mail is understood as registration of your xloops installation.

A typical run of configure is given in appendix A.1. configure automatically creates
the xloops executable file.

If you have root access you can make it executable for all users. You then can set a
symbolic link to /usr/bin, i.e.

cd /usr/bin

ln -s 〈directory〉/xloops/xloops .

where 〈directory〉 is the directory where xloops was installed.
If you don’t have bash you can find the necessary instructions in the file README which

is part of the xloops distribution.

2.3 Getting started

You can now type
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./xloops

from the directory where xloops was installed before. This starts your xloops session. The
main window of xloops (cf. fig. 3.1) will appear. If xloops was made executable for all users
(cf. previous section) it can be started with

xloops

from any directory.

There is on principle no restriction in the number of xloops sessions which can be used
simultaneously – by the same user or by different users. On the other hand the numerical
integration with VEGAS should be used only once by each user (cf. sect. 4.6).

2.4 Installing the Maple part only

If you are only interested in the Maple routines you have to start the installation as in
sect. 2.2, but you then skip configure and just copy all files with extension .ma

⊲ loops.ma

⊲ fmrules.ma

⊲ fmuser.ma

⊲ evalproc.ma

⊲ oneloop.ma

⊲ cfcn.ma

⊲ pv.ma

⊲ r.ma

⊲ simple.ma

⊲ twoloop.ma

⊲ numint.ma

⊲ values.ma

⊲ unvalue.ma

⊲ mess.ma

in one directory instead and delete the rest of the distribution. The correct .ma files you
can find in the subdirectory xloops/MapleVR1 – if you use release 1 or 2 – or in the
subdirectory xloops/MapleVR3 – if you have release 3 or higher.
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2.5 Usage within a Maple session

You can use xloops within an ordinary Maple session as well: After having started Maple
just type the following lines:

LoopPath:=〈path〉;
read‘〈path〉loops.ma‘;

〈path〉 describes the directory where the .ma files are located. If the xloops package is
installed properly this should be the path of the xloops directory to which you have to add
MapleVR1 – if you are using release 1 or 2 of Maple V – or MapleVR3 – if you are using
release 3 or higher. If the .ma files were copied to the current directory before you can skip
the assignment of LoopPath and only type

read‘loops.ma‘;

Now you can use the functions described in chapter 4.
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3.1 Main window

After having typed the command xloops the main window (cf. fig. 3.1) appears on the
screen. It consists of three parts:

1. The menu bar which contains several menues for xloops commands (for details cf.
sect. 4.1.1).

2. The topology bar which displays all possible topologies for a definite m-loop n-point
function. The selection of m closed loops and n external lines is done with the help
of the menues Loops and Ext. Lines.

3. The text window with scroll bar which contains the results of calculations.

Maple text window

menu bar topology bar

Figure 3.1: Main window
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Before we will explain the functions and their meanings in detail in the next chapter,
we demonstrate here as an example how to use xloops for the calculation of a two-loop
self-energy diagram and a one-loop vertex correction.

3.2 Two-loop self-energy

We now perform the calculation of a diagram which contributes to the Higgs self-energy Σ
at the two-loop level:

H

H H

H H

H H

The underlying topology is the master topology, which is located in the fourth place in
the topology bar (cf. fig. 3.1). In this case the number of external lines and the number of
closed loops is already fixed correctly, so one now has just to click on the topology.

Then the master topology appears in a separate window, the diagram window (cf.
fig. 3.2). In this window for each internal and external particle the corresponding particle
name has to be inserted. Only particles can occur here, no antiparticles. The allowed terms
for particle names are listed in sect. 4.2.4. They can be obtained alternatively with the
menu Help. The flow of charges and fermion or ghost numbers is determined by the arrows
of the lines. The direction of an arrow is reverted with a click on it.

Figure 3.2: The diagram for the two-loop Higgs self-energy
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Since in our example we have to deal only with chargeless scalars, the direction of
arrows is meaningless and we have to insert the name H or higgs for each particle only.

For the sake of clearness, the flow of external momenta in our conventions is displayed
in blue. In this example there is only one momentum

q1 = (q10, 0, 0, 0) = (q10, 0) .

Vanishing components are put together to a common zero-vector. In our case there exists
only one parallel space component q10. The orthogonal space is represented through a
common 0.

When all particles are inserted, xloops is ready for calculation. The diagram window

gives you the possibility to select different modes of evaluation.

⊲ Click on the
✄

✂

�

✁
Evaluate button: The output – for simplicity – is returned in terms of

Oneloop and Twoloop functions which correspond directly to one-loop and two-loop
functions explained in sect. 4.3 and 4.4. In our example the result consists only of
the scalar master two-loop two-point function which xloops calls Twoloop2Pt2:

> G1 := EvalGraph2 (7, [higgs,higgs,higgs,higgs,higgs,higgs,higgs,higgs,higgs,

> higgs,higgs,higgs] );

G1 := [

81 8 4 2 2 2 2 2 2

C1 = ---- I Mhiggs e (1 + 2 eps Ln(4 Pi MU ) + 2 eps Ln(4 Pi MU ) )

8192

Twoloop2Pt2(0, 0, 0, 0, 0, q10, Mhiggs, Mhiggs, Mhiggs, Mhiggs, Mhiggs)

/ 4 4 8

/ (sin(tw) Mw Pi ),

/

C1]

Generally, the output is decomposed in one or several form factors C1, C2, . . . to
reflect the Dirac γ or Lorentz structure of the result. Therefore the result is a list of
form factors. The last entry in this list is the defining equation for the form factors.
In our example of a scalar self-energy there appears only one form factor C1 and the
defining equation is just the scalar C1. A more complicated situation can be found
in the next section (for details cf. sect 4.2.10).

Moreover xloops assigned the whole result to a variable G1. Within an xloops session
each calculation will get such a name in an unique way. This gives the user the
opportunity to perform further calculations with the results of diagrams, for instance
to sum up all evaluated graphs which contribute to the same process.

⊲ Click on the
✄

✂

�

✁
Eval. Full button: xloops evaluates directly the Oneloop and Twoloop

integrals. Now each form factor C1, . . . is a Laurent expansion in terms of the ultra-
violet regulator ε, where the significant coefficients of this expansion – O(ε−1), O(ε0)
in the one-loop case, O(ε−2), O(ε−1), O(ε0) in the two-loop case – are denoted in
form of a list (cf. sect 4.2.10).

For those two-loop topologies where no analytic result is known – like in the case
of our example, the finite part contributes two entries to the output list. The first
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of them is a list itself which denotes an integral representation, the second contains
the part which is analytically calculable:

GF1 := [

C1 = [0, 0,

8 4

81 Mhiggs e

[---- ----------------,

8192 4 4 4

sin(tw) Mw Pi

2 2

2 Mhiggs 2 Mhiggs

I Ln(Sqrt(x - ------- + I rho) + %1 + Sqrt(y - 2 y + 1 - ------- + I rho))

2 2

q10 q10

4 ----------------------------------------------------------------------------

2

q10 (- 2 x - 1) (- 2 y + 1)

2

2 Mhiggs

- 4 I Ln(Sqrt(x + 2 x + 1 - ------- + I rho) + %1

2

q10

2

2 Mhiggs / 2

+ Sqrt(y - 2 y + 1 - ------- + I rho)) / (q10 (- 2 x - 1) (- 2 y + 1))

2 /

q10

2 2

2 Mhiggs 2 Mhiggs

I Ln(Sqrt(x - ------- + I rho) + %1 + Sqrt(y - ------- + I rho))

2 2

q10 q10

- 4 ------------------------------------------------------------------ + 4

2

q10 (- 2 x - 1) (- 2 y + 1)

2 2

2 Mhiggs 2 Mhiggs

I Ln(Sqrt(x + 2 x + 1 - ------- + I rho) + %1 + Sqrt(y - ------- + I rho))

2 2

q10 q10

----------------------------------------------------------------------------

2

q10 (- 2 x - 1) (- 2 y + 1)

,

x = - infinity .. infinity, y = - infinity .. infinity],

0],

C1]
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2

2 2 Mhiggs

%1 := Sqrt(x + 2 x y + y - ------- + I rho)

2

q10

In our example the result is finite, therefore the first two entries in the list are zero.
The only nonvanishing contribution comes from the integral representation. A more
detailed description of the integral representation is given in sect. 4.4.3.

The result is a function of the Higgs mass Mhiggs and the external momentum q10.
The coupling of the vertices involve the W mass Mw, the Weinberg angle tw and the
electromagnetic coupling constant e. rho denotes the infinitesimal imaginary part
of the masses in the denominator (cf. sect. 4.2.10), x and y are the variables which
have to be integrated out numerically.

⊲ Click on the
✄

✂

�

✁
Eval. Numeric button: The integral representation described above is

evaluated directly with the help of VEGAS. This option exists only for two-loop
integrals, because all one-loop integrals are analytically calculable.

Please be aware that xloops can only perform the numerical integration if all variables
– Mhiggs and q10 in our example – are assigned with numerical values. For that
purpose the menu File provides the Insert Maple Command entry. If this option is
selected, a window (cf. fig. 3.3) appears, where any command can be passed directly
to Maple. In our example we insert

q10:=91.17;

Mhiggs:=300;

to evaluate the integral on the Z resonance for an assumed value of 300 GeV for the
Higgs mass. After clicking on

✄

✂

�

✁
Eval. Numeric xloops starts the numerical integration.

Figure 3.3: Direct Maple input of masses and momenta

The result including the numerical uncertainty appears in the main window and
reads:

GM1 := [

C1 = [0, 0,

4

16 e

[.66598680119771701375*10 ------------,

4 4

sin(tw) Mw
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-8 -5 -7 -7

[ - .354349*10 + .880157*10 I, .13042*10 + .148817*10 I]], 0],

C1]

In the result – compared to the
✄

✂

�

✁
Eval. Full option – the integral representation is

now replaced by the numerical result of the integral. This result consists of a list:
a pre-factor and another list. This list contains two entries: first the result of the
VEGAS calculation, then the uncertainty VEGAS detected for this result (for details
cf. sect. 4.2.10).

In our example the real part of the diagram is less than the numerical uncertainty,
whereas the imaginary part is significantly larger. This means that the real part in
fact is zero. Since we calculated the entire diagram which is not precisely Σ but −iΣ,
this is what one expects below threshold.

Alternatively to the direct input of Maple commands described above it is possible
to assign all known masses of particles, couplings and elements of the CKM matrix
with the option Insert Particle Properties of the Options menu.

The input information for VEGAS can also be determined with the menu Options:
Click on Numeric and an additional window will appear where the input parameters
for VEGAS can be fixed (for details cf. sect. 4.1.4).

Finally the result can be saved in text mode to a file. Use in the menu File the entry
Save Maple Output.

⊲ Click on the
✄

✂

�

✁
Close button: The diagram window disappears.

The four buttons described above are completely independent. You can for example select
✄

✂

�

✁
Eval. Numeric without having clicked on

✄

✂

�

✁
Evaluate or

✄

✂

�

✁
Eval. Full before.

3.3 One-loop vertex correction

What follows is the calculation of a one-loop contribution of the correction to the eeZ
vertex:

Z

e

e

γ

First one has to select the correct values in the menues Loops and Ext. Lines of the main

window to get access to the one-loop three-point topologies. A click on the correct topology
opens the diagram window (cf. fig. 3.4) where the particle names have to be inserted. Again
the correct particle names can be found in sect. 4.2.4 or in the menu Help. The direction of
the fermion line must be adjusted by clicking on the arrows. The flow of external momenta
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Figure 3.4: The diagram for the eeZ one-loop vertex correction

is displayed in blue again. The three momenta are

q1 = (q10, 0, 0, 0) = (q10, 0)

q2 = (q20, q21, 0, 0) = (q20, q21)

q1 − q2 = (q10 − q20,−q21, 0, 0) = (q10 − q20,−q21)

where the vanishing orthogonal space components are not displayed in the window.
q10, q20, q21 are the kinematical variables xloops uses for three-point functions. To get a
numerical result, we assign these variables with

q10:=Mz0; q20:=Mz0/2; q21:=evalf(sqrt(Mz0^2/4-Melec^2));

using the option Insert Maple Command of the menu File so that all external particles
are on-shell. Moreover the masses and couplings are assigned by the option Insert Particle
Properties of the Options menu. The renormalization scale MU and the unit GeV can be
omitted by setting

MU:=1; GeV:=1;

Clicking on the
✄

✂

�

✁
E. Full button gives the following result:

GF2 := [

C1 = [.000010058632263504308717 I,

- .00086276496443282788638 - .0072236143340212361270 I],

C2 = [.00010510130634321490041 I,

- .0090149159887518402249 - .075478582279918574719 I],

C3 = [0, .00083116483915048522171 + .0071524795241752712917 I],
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C4 = [0, .0086847304974275009526 + .074735304153769864092 I],

-9 -8

C5 = [0, .40863107990668029069*10 + .35164209243516742716*10 I],

C6 = [0, .000018229897665296319548 + .00015687498271956514041 I],

C7 = [0, .00019048176819004810260 + .0016391657617525244669 I],

-28 -27

C8 = [0, - .25407817700937862122*10 - .21701516787925566779*10 I],

C9 = [0, .000017536874322335126422 + .00015153965406412662322 I],

C10 = [0, .00018324045975332954356 + .0015834176245538375947 I],

-9 -8

C11 = [0, - .20431553995334014636*10 - .17582104621758371369*10 I],

-8 -7

C12 = [0, .22971899930888218199*10 + .19620932339352982103*10 I],

-25

C13 = [ - .24074590585723032270*10 I,

-6 -5

.34651167097341202104*10 + .28882798115295165844*10 I],

-5

C14 = [0, .36206542130597753444*10 + .000030179250351750043557 I],

-28 -27

C15 = [0, .12703908850468931061*10 + .10850758393962783388*10 I],

-6 -5

C16 = [0, .34651167090811890878*10 + .26676643227928772485*10 I],

-5

C17 = [0, .36206542123775363980*10 + .000027874068547868333215 I],

C1 (1 &* Dg(nu1)) + C2 &*(1, Dg5, Dg(nu1)) + C3 &*(1, Dg0, Dg1, Dg(nu1))

+ C4 &*(1, Dg5, Dg0, Dg1, Dg(nu1)) + C5 (1 &* ONE) q2(nu1)

+ C6 (1 &* Dg0) q2(nu1) + C7 &*(1, Dg5, Dg0) q2(nu1)

+ C8 &*(1, Dg0, Dg1) q2(nu1) + C9 (1 &* Dg1) q2(nu1)

+ C10 &*(1, Dg5, Dg1) q2(nu1) + C11 (1 &* ONE) q1(nu1)

+ C12 (1 &* Dg5) q1(nu1) + C13 (1 &* Dg0) q1(nu1)

+ C14 &*(1, Dg5, Dg0) q1(nu1) + C15 &*(1, Dg0, Dg1) q1(nu1)

+ C16 (1 &* Dg1) q1(nu1) + C17 &*(1, Dg5, Dg1) q1(nu1) ]

The output is decomposed in several form factors C1, C2, . . . to reflect the Dirac γ and
Lorentz structure of the result. The last entry in this list is the defining equation for the
form factors (cf. sect. 4.2.10).
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There are two intentions covered by xloops:

⊲ Either the calculation of complete Feynman diagrams. Here you need the Evaluate
Graph window (see sect. 4.1) where you can insert particles into a Feynman diagram.
Alternatively you can use the EvalGraph procedures in Maple described in sect. 4.2.

⊲ Or the solution of single integrals occurring in the calculation of one- and two-loop
diagrams. Then you can make use of the OneLoop and TwoLoop procedures explained
in sect. 4.3 and 4.4.

The creation of a library for the integrals follows in sect. 4.5. The numerical integration
of two-loop integrals is explained in sect. 4.6.

4.1 The Xwindows interface

4.1.1 The functions of the menu bar

The menu bar provides a variety of different functions for the user. These functions are
combined to groups which appear as menues if the user clicks on it. The list below gives
a short overview. Additional descriptions can be found in the following sections.

⊲ The menu File (cf. fig. 4.1a) has the following entries:

⊲ Insert Maple Command allows the insertion of an arbitrary command which is
passed directly to Maple (cf. fig. 3.3). Especially the numerical input of masses,
momenta and renormalization conditions can be done easily this way.

⊲ Save Maple Output saves the output as it is denoted in the Maple text window to
an extra file. The name of the file has to be determined in a separate window,
which appears if the user clicks on this entry.

⊲ New Process allows the user to collect a set of graphs and save them with a
common process name. Detailed explanation can be found in section 4.1.3.

⊲ With Load Process processes which were declared with New Process before can
be reloaded into the current xloops session (cf. sect. 4.1.3).

⊲ Create Process will call the graph generator to produce all graphs to a given
number of loops and external lines in a pre-defined model (in future versions of
xloops only).

⊲ Restart Maple terminates the current Maple session and removes all assigned
variables. Maple and xloops are started again.

⊲ Quit terminates xloops.
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(a) (b) (c)

(d) (e) (f)

Figure 4.1: The menues of the menu bar

⊲ The menu Model (cf. fig. 4.1d) offers several physical models for calculation (for
details cf. sect. 4.2.3).

⊲ The menu Loops (cf. fig. 4.1e) selects the number of closed loops for the calculation.
The user can choose between 0, 1 and 2. A change of this value results in different
topologies displayed in the topology bar.

⊲ The menu Ext. Lines (cf. fig. 4.1f) allows the user to choose the number of external
lines. At the moment the upper limit is three. The change of this number results in
a different topology bar as well.

⊲ The menu Options (cf. fig. 4.1c) contains the following entries:

⊲ If History is selected xloops saves all calculations under a common process name.
Those diagrams which were already saved before are read from disk. Otherwise,
if History is not selected they are recalculated (cf. sect. 4.1.3).

⊲ With the selection of Oneloop Library xloops takes all one-loop functions from
a pre-built library. Otherwise the one-loop functions are calculated every time
they are needed (cf. sect. 4.5 and appendix B.2).

⊲ If Insert Particle Properties is selected the values of masses and couplings reported
by the Particle Data Group [11] are inserted (cf. sect. 4.2.4).

⊲ Set Neutrino Masses 0 assigns all neutrino masses to zero (default) or, if not se-
lected, leaves the neutrino masses unassigned. In this case an undefined neutrino
mixing matrix exists as well (cf. sect. 4.2.4).
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⊲ Massless Light Fermions assigns the masses of all fermions except the b and t
quark to zero (cf. sect. 4.2.4).

⊲ Numeric defines the number of points and the number of iterations for the
numerical integration with VEGAS (cf. sect. 4.6).

⊲ Window Options allows the user to adjust the appearance of the Xwindows in-
terface, especially the placement of the red arrows of the diagram window (cf.
sect. 4.1.4).

⊲ Save Options saves all options in the file .xloops in the home directory of the
user.

⊲ The menu Help (cf. fig. 4.1b) has three entries:

⊲ About shows a brief information on xloops.

⊲ Help gives a short help where especially the notation of all particle names in
xloops is written.

⊲ Tutorial calls a WWW browser which displays the on-line html version of this
manual.

4.1.2 Topology bar and diagram window

According to the pre-defined values for the numbers of closed loops and external lines the
topology bar displays all possible topologies. If the user clicks on one of them this topology
appears in a separate window, the diagram window. This window consists of three parts: a
menu bar, an area for inserting particles (diagram area) and a command bar with different
buttons for evaluation (cf. fig. 4.2).

The menu bar provides two options. The right one, Export, gives the user the possibility
to export the graph to a Postscript file. Only the diagram area of the diagram window is
exported, menu bar and command bar are not included.

The left option, Subtopologies, will only be available in future versions. It will provide
the possibility to switch between several subtopologies, which are obtained when external
lines are interchanged. The upper topology in fig. 4.2 may serve as an example. This
topology can be rotated by 120◦ or 240◦ which corresponds to a cyclic permutation of the
external lines. This changes the topology to the same type of topology but with different
momentum flow. In contrast, the lower topology in fig. 4.2 does not change if it is rotated
by 120◦ or 240◦. So this topology does not exhibit different subtopologies.

In the diagram area the topology is displayed graphically. For every propagator an
entry for the insertion of particles is located. The correct terms for particle names are
written in section 4.2.4. They can also be obtained from the Help function of the main

window. The flow of charge and fermion and ghost numbers are determined by the red
arrows on the propagator lines. Clicking on an arrow changes its direction. The correct
flow of charge and fermion and ghost numbers can be settled in this way. Only particles,
no antiparticles can be inserted. Charge conjugation may be achieved by inversion of
arrows. Please keep in mind that the arrows don’t describe the direction of momenta. The
convention of momentum flow is shown graphically in the diagram window in blue. It is
defined for all diagrams in the same way, to facilitate a final summation of all calculated
diagrams.

If the user has inserted all particles and checked the charge flow, the command area

gives him several possibilities for the evaluation of the diagram. They correspond to the
different modes of evaluation as explained in section 4.2.10.
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command bar

menu bar
particle entry

charge flow

momentum flow

Figure 4.2: Different diagram windows
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4.1.3 Loading and saving of processes

For the evaluation of complete processes it is possible to save the contributing graphs with
a common process name. Therefore xloops provides the File menu entries Load Process and
New Process.

If Load Process is selected the file window (cf. fig. 4.3) appears on the screen. In this

Figure 4.3: The Load Process file window

window the processes which were already saved are listed on the left hand side. In addition
for every process a user specified description is given on the right hand side. This may
help to reidentify a process later. To select a specific process one clicks on a process name
on the left. After clicking on the

✄

✂

�

✁
OK button the history table (cf. fig 4.4) of the selected

process appears whereas
✄

✂

�

✁
Cancel closes the file window. In the history table all diagrams

which were included in the corresponding process occur with a button. A click on such
a button opens a diagram window (cf. fig 4.2) with which the Feynman diagram can be
evaluated. The history table contains two menues:

⊲ In Graphs one has the opportunity – if the number of diagrams exceeds the capacity
of the window – to switch to another sheet of diagrams. The same effect have the
arrows at the bottom of the history table.

⊲ Close lets the history table disappear.

If the entry History of the Options menu is selected all results are saved. With History
all calculations which were already saved in this or another xloops session are read in
automatically and not calculated again. For each process xloops automatically creates a
subdirectory of the directory xloops_user where the results are saved to different files.

If History is selected without having specified a process before xloops assumes that a
new process shall be added to the list and opens a similar file window (cf. fig 4.5) – the
same window appears if New Process is selected. Two entries are provided for inserting a
new process name and description at the bottom of the window. After the user inserted the
name and description for his process and clicked on the

✄

✂

�

✁
OK button a new – and therefore

empty – history table appears on the screen. All diagrams which are calculated from now
are included in the history table as additional entries. The topology of the graph and the
list of interacting particles are displayed.
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single diagram

particle list
topology

diagram numbers shown

menu for selecting abritrary diagrams

forward/backwards in diagram list

Figure 4.4: The history table containing diagrams of the process H → H
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Figure 4.5: The New Process file window

4.1.4 Window options

With the entry Window Options of the Options menu the appearance of some windows of
xloops can be adjusted to fit the terminal characteristics (cf. fig. 4.6). First, the size of the

Figure 4.6: Window options of xloops

history table (cf. fig. 4.4) can be changed by decreasing or increasing the numbers of the
Rows and Columns entry in fig. 4.6. Then, the position of the arrows of the propagators in
the diagram window can be corrected. This might be necessary on some terminal types,
where the arrows of the propagators are misplaced. This has to do with the fact that the
relation between screen dots (as used by Tk) and centimeters is different on different X
terminals. The embarrassing consequence can be that the arrows of the propagators are
misplaced. The problem can be avoided by inserting a global Scale Factor. Alternatively,
if this factor is not obvious, xloops will calculate it. Therefore the user must insert the
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position of the arrow on the ruler in the Arrow Scaling field of fig. 4.6.1

4.2 Evaluation of Feynman diagrams

4.2.1 Input

To evaluate a particular Feynman diagram xloops needs to know four ingredients:

1. The number of closed loops.

2. The number of external lines.

3. The topology, that means the information how the lines of the diagram are connected.

4. The particles of the diagram.

The first two numbers have to be selected with the help of the menu bar entries Loops and
Ext. Lines (cf. sect. 4.1.1). Then the topology can be selected on the topology bar so that
the diagram window pops up where the particles can be inserted (cf. sect. 4.1.2).

Internally the input from the Xwindows interface is converted to a procedure which
performs the calculations in Maple. It is also possible to start directly from this routine
for Maple – either with the Insert Maple Command of the File menu or within an ordinary
Maple session where the Maple part of xloops was read in before (cf. sect. 2.5).

For that purpose the internal Maple commands will be mentioned in the following. All
commands which follow without reference to the Xwindows interface have to be passed to
Maple.

The input is then of the following form

⊲ for tree diagrams: EvalGraph0(n,〈list〉);

⊲ for one-loop diagrams: EvalGraph1(n,〈list〉);

⊲ for two-loop diagrams: EvalGraph2(n,〈list〉);
The different topologies with the same number of loops are numbered. The number of the
desired topology has to be inserted in the function call for n. The correct number for each
topology will be given below in sect. 4.2.2. 〈list〉 describes the list of particles involved in
the Feynman diagram. The conventions for the ordering of the particles are also explained
for every topology in 4.2.2.

4.2.2 Internal Notation

What follows is a list of all topologies which at present can be solved by xloops. This list
is only of interest for direct Maple input. To fix the flow of charges and of fermion or
ghost numbers in an unique way, each internal propagator is assigned with two particle
names. For example [up,upbar] and [upbar,up] describe the up-quark propagator but
with different direction of the quark line arrow. External lines are described by only one
particle name.

As a convention all particles at each vertex are incoming. The arrows of the diagrams
displayed below only describe the flow of momenta. Of course these arrows need not to
coincide with the arrows of fermions or other charged particles.

For each topology we give the correct EvalGraph command as well as the command
for the corresponding OneLoop or TwoLoop integral.

1If the scaling factor is already correct, the arrow should point on the 5.
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Tree level

Three-point diagrams

EvalGraph0(1, [©1 ,©2 ,©3 ])

©1

©3

©2

q1

q2

q2 − q1

Four-point diagrams

EvalGraph0(2, [©1 ,©2 ,©3 ,©4 ])

©1

©2 ©3

©4 q3

q3 − q2q2 − q1

q1
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One-loop level

One-point diagrams

EvalGraph1(1, [©1 ,©2 ,©3 ])

©1

©2

©3

lm

OneLoop1Pt(p,m)

Two-point diagrams

EvalGraph1(2, [©1 ,©2 ,©3 ,©4 ])

©1 ©2

©3©4

l

m

q1 q1

OneLoop1Pt(p,m)
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EvalGraph1(3, [©1 ,©2 ,©3 ,©4 ,©5 ,©6 ])

©1 ©2

©3

©4 ©5

©6

m1

m2

l + q1

l

q1 q1

OneLoop2Pt(p0, p⊥, q10,m1,m2)

Three-point diagrams

EvalGraph1(4, [©1 ,©2 ,©3 ,©4 ,©5 ,©6 ,©7 ])

©1
©2

©3©4

©5 ©6

©7

l + q1

l

m1

m2

q1

q2

q2 − q1

OneLoop2Pt(p0, p⊥, q10,m1,m2)

EvalGraph1(5, [©1 ,©2 ,©3 ,©4 ,©5 ,©6 ,©7 ,©8 ,©9 ])

©1

©2

©3

©4

©5

©6

©7

©8

©9

l + q1

l + q2

l

m1

m2

m3q1

q2

q2 − q1

OneLoop3Pt(p0, p1, p⊥, q10, q20, q21,m1,m2,m3)
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Two-loop level

Two-point diagrams

EvalGraph2(6, [©1 ,©2 ,©3 ,©4 ,©5 ,©6 ,©7 ,©8 ,©9 ,©10 ,©11 ,©12 ])

©1 ©2
©3

©4 ©5

©6

©7

©8
©9©10

©11

©12

q1 q1

k

l + q1

ll
l + k

m1

m2m3

m4

m5

TwoLoop2Pt1(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4,m5)

EvalGraph2(7, [©1 ,©2 ,©3 ,©4 ,©5 ,©6 ,©7 ,©8 ,©9 ,©10 ,©11 ,©12 ])

©1 ©2

©3

©4

©5 ©6
©7

©8
©9©10

©11

©12
q1 q1

k − q1

kl

l + q1

l + k

m1

m2

m3

m4

m5

TwoLoop2Pt2(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4,m5)
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EvalGraph2(8, [©1 ,©2 ,©3 ,©4 ,©5 ,©6 ,©7 ,©8 ,©9 ,©10 ])

©1 ©2

©3

©4
©5 ©6

©7

©8
©9

©10

q1 q1

l

l + q1

k

l + k

m1

m2m3

m4

TwoLoop2Pt3(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4)

EvalGraph2(9, [©1 ,©2 ,©3 ,©4 ,©5 ,©6 ,©7 ,©8 ])

©1 ©2

©3
©4

©5 ©6

©7
©8

q1 q1

l + q1

l + k

k

m1

m2

m3

TwoLoop2Pt4(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3)



32 4 Detailed description

EvalGraph2(10, [©1 ,©2 ,©3 ,©4 ,©5 ,©6 ,©7 ,©8 ,©9 ,©10 ])

©1 ©2
©3

©4 ©5

©6

©7

©8©9

©10
q1 q1

k

l + q1

l l

m1

m2m3

m4

TwoLoop2Pt5(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4)

EvalGraph2(11, [©1 ,©2 ,©3 ,©4 ,©5 ,©6 ,©7 ,©8 ,©9 ,©10 ])

©1 ©2

©3

©4 ©5 ©6

©7©8

©9

©10
q1 q1

k

k − q1

l

l + q1

m1

m2

m3

m4

TwoLoop2Pt6(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4)

For each encircled number one particle has to be inserted. The correct symbols for all
allowed particles are listed in the next section. The conventions for the OneLoop and
TwoLoop functions are denoted in sect. 4.3 and 4.4.

4.2.3 Models

xloops distinguishes several models. The menu Model of the menu bar serves for the selection
of the desired model. Internally the global variable Model selects the model which shall be
used. The following models are declared in xloops:
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⊲ Standard Model – the (minimal) standard model (electroweak and QCD). This cor-
responds to Model:=SM; and is the default value

⊲ 2 Higgs Doublets Model – the standard model with two Higgs doublets which corre-
sponds to five physical Higgs particles; Model:=THDM;

⊲ QCD – QCD with three generations of Quarks; Model:=QCD;

⊲ Electroweak Theory – the electroweak sector of the standard model; Model:=EW;

⊲ QED – QED with three generations of Leptons and Quarks; Model:=QED;

⊲ Phiˆ4 Theory – φ4-theory in four dimensions; Model:=phifour;

⊲ Phiˆ3 Theory – φ3-theory in four dimensions; Model:=phithree;

⊲ Goldstone Boson Equiv. Model – the equivalence model for Goldstone bosons –
standard model vector bosons are replaced by scalar Goldstone modes [12–14];
Model:=GBEM;

⊲ a user-defined model where arbitrary Feynman rules can be declared. To work with
this option the user has to set Model:=user; and to read an additional file

read‘〈path〉fmuser.ma‘;

where 〈path〉 is the same path used for the assignment of LoopPath at the beginning
of the Maple session (cf. sect. 2.5). In the file fmuser.ma the user-defined rules have
to be inserted. Initially all QCD Feynman rules are denoted there as an example.
The conventions of declaration can be taken from this example.

4.2.4 Particles and Masses

What follows is a list which contains all particles xloops knows. The names valid in the
Xwindows interface are denoted (second column from the left) as well as the names for
internal use within Maple (third column from the left). In addition for each particle the
models in which it is declared (right column) and the name which xloops uses for the
corresponding particle mass (second column from the right) are listed.
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©1 ©2
mφ

f, phi
©1 = phi

©2 = phi
mφ = Mphi

phithree,

phifour

©1 ©2
mνe

ve, nuelec
©1 = nuelec

©2 = nuelecbar
mνe

= Mnuelec
SM, EW, QED,

THDM, GBEM

©1 ©2
me

e, elec
©1 = elec

©2 = elecbar
me = Melec

SM, EW, QED,

THDM, GBEM

©1 ©2
mνµ

vµ, numu
©1 = numu

©2 = numubar
mνµ

= Mnumu
SM, EW, QED,

THDM, GBEM

©1 ©2
mµ

µ, mu
©1 = mu

©2 = mubar
mµ = Mmu

SM, EW, QED,

THDM, GBEM

©1 ©2
mντ

vy, nutau
©1 = nutau

©2 = nutaubar
mντ

= Mnutau
SM, EW, QED,

THDM, GBEM

©1 ©2
mτ

y, tau
©1 = tau

©2 = taubar
mτ = Mtau

SM, EW, QED,

THDM, GBEM

©1 ©2

mu

u, up
©1 = up

©2 = upbar
mu = Mup

SM, EW, QED,

QCD, THDM, GBEM
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©1 ©2
md

d, down
©1 = down

©2 = downbar
md = Mdown

SM, EW, QED,

QCD, THDM, GBEM

©1 ©2
mc

c, charm
©1 = charm

©2 = charmbar
mc = Mcharm

SM, EW, QED,

QCD, THDM, GBEM

©1 ©2
ms

s, strange
©1 = strange

©2 = strangebar
ms = Mstrange

SM, EW, QED,

QCD, THDM, GBEM

©1 ©2
mt

t, top
©1 = top

©2 = topbar
mt = Mtop

SM, EW, QED,

QCD, THDM, GBEM

©1 ©2
mb

b, bottom
©1 = bottom

©2 = bottombar
mb = Mbottom

SM, EW, QED,

QCD, THDM, GBEM

©1 ©2

mγ

˜, gamma
©1 = gamma

©2 = gamma
mγ = Mgamma = 0

SM, EW, QED,

THDM, GBEM

©1 ©2

mW

W, wp
©1 = wp

©2 = wm
mW = Mw

SM, EW,

THDM, GBEM

©1 ©2

mZ

Z, z0
©1 = z0

©2 = z0
mZ = Mz0

SM, EW,

THDM, GBEM
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©1 ©2

mg

g, gluon
©1 = gluon

©2 = gluon
mg = Mgluon = 0 SM, QCD, THDM

©1 ©2
mH

H, higgs
©1 = higgs

©2 = higgs
mH = Mhiggs SM, EW, GBEM

©1 ©2
g+, goldp

©1 = goldp

©2 = goldm
— SM, EW, THDM

©1 ©2
g0, gold0

©1 = gold0

©2 = gold0
— SM, EW, THDM

©1 ©2
mH0

H, Higgs0
©1 = Higgs0

©2 = Higgs0
mH0

= MHiggs0 THDM

©1 ©2

mh0

h, higgs0
©1 = higgs0

©2 = higgs0
mh0

= Mhiggs0 THDM
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©1 ©2
mH

H+, Higgsp
©1 = Higgsp

©2 = Higgsm
mH = MHiggs THDM

©1 ©2
mA0

A0, a0
©1 = a0

©2 = a0
mA0

= Ma0 THDM

©1 ©2
G˜, ghostgamma

©1 = ghostgamma

©2 = ghostgammabar
— SM, EW, THDM

©1 ©2
GZ, ghostz0

©1 = ghostz0

©2 = ghostz0bar
— SM, EW, THDM

©1 ©2
©+

GW+, ghostwp
©1 = ghostwp

©2 = ghostwmbar
— SM, EW, THDM

©1 ©2
©–

GW–, ghostwm
©1 = ghostwm

©2 = ghostwpbar
— SM, EW, THDM

©1 ©2
Gg, ghostgluon

©1 = ghostgluon

©2 = ghostgluonbar
— SM, QCD, THDM
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Please note that the masses of the neutrinos are set to zero by default. To keep them as
variables, one can switch off the entry Set Neutrino Mass 0 of the Options menu or use

UnsetNeutrinoMass0();

within Maple which removes any assignment of Mnuelec, Mnumu and Mnutau. As a conse-
quence now a leptonic CKM matrix exists which behaves analogous to the usual CKM
matrix of quarks (cf. sect. 4.2.6). The reverse command

SetNeutrinoMass0();

or the reselection of Set Neutrino Mass 0 sets all neutrino masses back to zero. The leptonic
CKM matrix equals now the unit matrix.

The masses of photon and gluon are also set to zero by default. To keep them as vari-
ables you have to type

Mgamma:=’Mgamma’; Mgluon:=’Mgluon’;

The masses of leptons and light quarks – all standard model fermions except b and t quark
– can collectively be set to zero with the entry Massless Light Fermions of the Options menu
or with

SetLightMass0();

and be unassigned with

UnsetLightMass0();

or another click on Massless Light Fermions. Apart from this, masses, momenta and cou-
plings – as they are explained in the following sections – can be assigned by the user.

Moreover, if you want to assign all particle masses2 as well as the couplings, the
Cabibbo-Kobayashi-Maskawa matrix (CKM matrix) and the Weinberg angle with their
experimentally determined values, you can use the entry Insert Particle Properties of the
Options menu or type

read‘〈path〉values.ma‘;

where 〈path〉 is the same path used for the assignment of LoopPath at the beginning of
the Maple session (cf. sect. 2.5). The file values.ma contains the parameters according to
the currently published data of the Particle Data Group [11]. To remove all information
of values.ma in a Maple session you can type

read‘〈path〉unvalue.ma‘;

or switch off the Insert Particle Properties entry. Instead of the fermion names which were
already introduced one can also use the more general terms

up1, up2, up3, down1, down2, down3 .

The difference is, that for these terms no electric charge Q and no weak isospin T3l is

2Unfortunately the Higgs mass is not yet included
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defined. While xloops assumes

Q(elec) = −1 ; T3l(elec) = −1
2 ; Q(up) = 2

3 ; T3l(up) = 1
2 ; . . .

it has no values for Q(up1), T3l(up1), . . . and the user has the opportunity to make use
of this freedom.

4.2.5 Feynman rules

Since the conventions for Feynman rules vary in the literature, it is important to explain
one’s own rules: We use Feynman gauge, for electroweak processes according to the rules
given in [15], but with all three-vertices and all propagators multiplied by −i and all four-
vertices and the integration measure multiplied by i. This convention coincides with the
rules of [16] – as far as these are applicable in Feynman gauge. From [16] we took the rules
for QCD and the notation of the CKM matrix, too. The rules for the Two Higgs doublet
model are from [17].

Anyway, you receive the rule for one particular vertex easily if you just use the tree
level topologies or call the EvalGraph0 procedure.

In our convention the electromagnetic coupling e and the strong coupling gs are posi-
tive (the electric charge of the electron is -e). xloops automatically inserts a factor (2π)2ε−4

for every closed loop and an additional −1 for each fermion and ghost loop. This means
that the dimension – which xloops calls D – equals 4 - 2 eps. The correct symmetry factor
of the diagram is also included. The scale which keeps the coupling constants dimensionless
is called MU.

4.2.6 Mixing angles and CKM matrix

Three mixing angles are known by xloops: The usual Weinberg angle tw and – only relevant
in the case of the Two Higgs doublet model – the angles alpha and beta (cf. [17]). The
elements of the CKM matrix are denoted by CKM(up,down) . . . , its complex conjugates
are CKMC(up,down) . . . . If neutrino masses are not set equal to zero there exists also a
leptonic CKM matrix with elements like CKM(nuelec,elec). If the neutrino masses are
set to zero – which is the default (cf. sect. 4.2.4) – this matrix equals the unit matrix.

4.2.7 Momenta and Metric

The external momenta q1(nu1), q2(nu1), . . . may occur in two different contexts,

1. as Lorentz vectors q1(nu1), . . . with Lorentz indices nu1, . . . ,

2. contracted with another Lorentz vector.

In the first case the momentum will appear in the output as it is. In the second case the
contraction will be written in terms of parallel space components:

q10 =

√

q1
2 ; q20 =

q1 · q2
√

q1
2

; q21 =

√

(q1 · q2)2

q1
2 − q2

2 ;

q30 =
q1 · q3
√

q1
2

; q31 = − q̂2 · q3
√

−q̂2
2

; q32 =

√

(q1 · q3)2

q1
2 +

(q̂2 · q3)2

q̂2
2 − q3

2 ,

(4.1)

where the auxiliary property

q̂2 = q2 − q1 · q2

q1
2 q1 (4.2)
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was used. In appendix A we demonstrate how this works in practice.

The metric tensor of xloops is G(nu1,nu2). It obeys the usual conventions

G(0,0) = 1 ; G(1,1) = −1 . . .

The contraction of G(nu1,nu2) depends on whether the indices nu1 and nu2 are orthogonal
space indices – then G(nu1,nu1) = D− DimP – or belong to the entire Minkowski space –
this means that G(nu1,nu1) = D.

The totally antisymmetric tensor is Eps(nu1,nu2,nu3,nu4) with Eps(0,1,2,3) = 1.

4.2.8 Dirac matrices

Dirac γ-matrices xloops calls Dg(mu1), . . . . Like the external momenta they can appear
either as Lorentz vector as they are, or contracted by another Lorentz vector. In the latter
case they are denoted by

Dg0 =
q/1

√

q1
2

; Dg1 = − q̂/2
√

−q̂2
2

; Dg2 = − q̂/3
√

−q̂3
2

(4.3)

with

q̂3 = q3 − q1 · q3

q1
2 q1 − q̂2 · q3

q̂2
2 q̂2 (4.4)

and the abbreviation (4.2). The Dirac structure is written as a string of the non-
commutative product &*. Since the program is also designed for diagrams with more
than one fermion line it labels each string of Dirac matrices with a number. For example
in the case of fermionic self-energies

&*(1,ONE) ; &*(1,Dg0) ; &*(1,Dg5) ; &*(1,Dg5,Dg0)

will occur in the output – the latter two of course only in the case of W,Z or Goldstone
boson exchange. ONE represents the identity of the Clifford algebra, Dg5 is γ5. The first
entry in the non-commutative string gives the number of the fermion line. The 1 means
that the string belongs to the first fermion line which in this case is the only fermion line.
In appendix A this treatment can be seen in practice.

4.2.9 SU(Nc) algebra

In QCD calculations xloops keeps the colour number Nc unassigned by default, but with

Nc:=3;

the number is fixed to its standard model value. The SU(Nc) algebra needs as ingredients

⊲ the identity matrix of the SU(Nc) algebra delta3(ta1,ta2) which should not be
mixed with Kronecker delta8(ta1,ta2) which contracts the Gell-Mann matrices
with the labels ta1 and ta2. Of course delta3(ta1,ta2) and delta8(ta1,ta2) are
both diagonal with entries 1 in the diagonal. This means that

∑

ta1

delta3(ta1,ta1) = Nc = 3 ;
∑

ta1

delta8(ta1,ta1) = N2
c − 1 = 8 .
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⊲ the Gell-Mann matrices Ts(ta1,ta2,ta3) themselves, where ta1 – which is the
number of the matrix – can take values from 1 to N2

c − 1. ta2 and ta3 are the
indices of a particular Gell-Mann matrix and therefore have values from 1 to Nc.
The Ts(ta1,ta2,ta3) are normalized by the following trace condition:

∑

ta3,ta4

Ts(ta1,ta3,ta4) Ts(ta2,ta4,ta3) = 2 delta8(ta1,ta2) .

⊲ the usual structure functions fs(ta1,ta2,ta3) and ds(ta1,ta2,ta3) where all
three indices vary from 1 to N2

c − 1. They are defined by the Lie algebra relation
∑

ta5

Ts(ta1,ta3,ta5) Ts(ta2,ta5,ta4)

=
2

Nc
delta8(ta1,ta2) delta3(ta3,ta4)

+
∑

ta5

ds(ta1,ta2,ta5) Ts(ta5,ta3,ta4)

+i
∑

ta5

fs(ta1,ta2,ta5) Ts(ta5,ta3,ta4) ,

where the fs(ta1,ta2,ta5) are completely antisymmetric and the ds(ta1,ta2,

ta5) are completely symmetric.

4.2.10 Output

The output of the diagrams is decomposed in one or several form factors C1, C2, . . . to
reflect the Dirac γ or Lorentz structure of the result. Therefore a list of form factors is
returned. The last entry in this list is the defining equation for the form factors. The result
is presented in the Maple text window of the main window and has the following structure:

G1 := [C1 = . . . , . . . , Cn = . . .
︸ ︷︷ ︸

the form factors Ci

, C1 q1(nu1) q2(nu2)+ · · · + Cn G(nu1,nu2) . . .
︸ ︷︷ ︸

defining equation for form factors

]

Let us consider for instance the self-energy of a vector boson. xloops finds as Lorentz
structure C1 G(nu1,nu2)+ C2 q1(nu1) q1(nu2) and the output roughly looks like

[C1 = term1 , C2 = term2 , C1 G(nu1,nu2)+ C2 q1(nu1) q1(nu2)] ,

where term1 and term2 denote the form factors. In the case of a fermionic self-energy
the result carries no Lorentz index. Instead, it is decomposed with respect to &*(1,ONE),
&*(1,Dg5), &*(1,Dg0) and &*(1,Dg5,Dg0) and in the general case the result is of the
form

[C1 = term1 , C2 = term2 , C3 = term3 , C4 = term4 ,

C1 (1 &* ONE)+ C2 (1 &* Dg5) + C3 (1 &* Dg0)+ C4 &*(1, Dg5, Dg0)] .

Here all γ-matrices are contracted. In vertex functions with a fermion line and a vector
boson there is also a Dg(nu1) appearing. In appendix A several examples are given in
more detail. In the case of a scalar self-energy there appears only one form factor and the
result reads

[C1 = term1 , C1] .

The form factors can be written in several modes of evaluation which correspond to the
different buttons of the diagram windows:
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⊲ With
✄

✂

�

✁
Evaluate or if no qualifier is added to the EvalGraph procedures the output –

for simplicity – is returned in terms of unevaluated Oneloop and Twoloop functions
which correspond directly to the OneLoop and TwoLoop functions explained in sect.
4.3 and 4.4.

⊲ To get complete answers,
✄

✂

�

✁
Eval. Full or in the case of EvalGraph1 and EvalGraph2 the

qualifier full forces xloops to evaluate directly the Oneloop and Twoloop integrals.
To be precise, you have to type

EvalGraphm(n,〈list〉,full);

where m and n are numbers. Now each form factor C1, . . . is a Laurent expansion in
terms of the ultraviolet regulator ε = (4−D)/2, where the significant coefficients of
this expansion – O(ε−1), O(ε0) in the one-loop case, O(ε−2), O(ε−1), O(ε0) in the
two-loop case – are denoted in form of a list. The bosonic self-energy we introduced
before now has the structure

[C1 = [ε−1-term, ε0-term] ,

C2 = [ε−1-term, ε0-term] , C1 G(nu1,nu2)+ C2 q1(nu1) q1(nu2)]

for one-loop contributions and

[C1 = [ε−2-term, ε−1-term, ε0-term] ,

C2 = [ε−2-term, ε−1-term, ε0-term] , C1 G(nu1,nu2)+ C2 q1(nu1) q1(nu2)]

for two-loop diagrams. ε−2-term and ε−1-term are meant to represent the divergent
part (the coefficients of 1

ε2 and 1
ε
) whereas ε0-term is describing the finite part of the

corresponding form factor. For those two-loop topologies where no analytic result is
known, the finite part contributes two entries to the output list. The first of them
is a list itself which denotes an integral representation, the second contains the part
which is analytically calculable:

[C1 = [ε−2-term, ε−1-term,numeric, ε0-term] ,

C2 = [ε−2-term, ε−1-term,numeric, ε0-term] ,

C1 G(nu1,nu2)+ C2 q1(nu1) q1(nu2)] .

A more detailed description of the integral representation – which was called here
numeric – is given in sect. 4.4.3.

⊲ The integral representation is evaluated directly with the help of VEGAS if
✄

✂

�

✁
Eval. Numeric is used or if the qualifier full replaced by two lists which contain the
input information for VEGAS:

EvalGraphm(n,〈list〉 ,[m1,m2],[n1, n2]);

Within an ordinary Maple session one has in addition to assign the variable NumPath
as described in sect. 4.6. The variables m1,m2, n1, n2 represent the grids where the in-
tegrand is evaluated: first m1 iterations with m2 points – itmx= m1 and ncall= m2

are passed to VEGAS – and then n1 iterations with n2 points – this corresponds to
itmx= n1 and ncall= n2. In the Xwindow interface these values can be changed
with the entry Numeric of the Options menu (cf. sect. 4.6). Real and imaginary part
are integrated one after the other.
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The output has then the following structure:

[C1 = [ε−2-term, ε−1-term, [factor, [result, error]], ε0-term] ,

C2 = [ε−2-term, ε−1-term, [factor, [result, error]], ε0-term] ,

C1 G(nu1,nu2)+ C2 q1(nu1) q1(nu2)]

where factor denotes an analytically evaluated pre-factor of the integrand. The re-
sult of the integral itself is called result here, error describes the uncertainty of the
numerical integration which is returned by VEGAS. To be specific: the entire O(ε0)
contribution is obtained by

factor × result + ε0-term,

the complete uncertainty is
factor × error,

where the uncertainty of ε0-term is neglected.

If not all parameters of the integrand carry numerical values the numerical integra-
tion cannot be performed. Therefore the same output as for the qualifier full is
returned.

⊲ With
✄

✂

�

✁
Eval. More or in the case of EvalGraph1, with the qualifier more instead of

full, xloops evaluates even the O(ε) of one-loop integrals. This becomes relevant
if the one-loop integral is part of a two-loop calculation, because then it may be
multiplied with a divergent one-loop Z-factor. This changes the output of a bosonic
self-energy:

[C1 = [ε−1-term, ε0-term, ε1-term] ,

C2 = [ε−1-term, ε0-term, ε1-term] , C1 G(nu1,nu2)+ C2 q1(nu1) q1(nu2)] .

As far as the masses and momenta which enter the EvalGraph functions are symbols the
output is given algebraically, whereas if they are all assigned with numbers the result will
be numerical.

Generally, in the numerical case, the program sets the value of the imaginary part of
the propagators, five digits higher than the numerical accuracy of the whole calculation,
for example to 10−15 if one calculates with 20 digits. When reading the program Maple
sets the number of digits to 20 – except when the user specified a higher accuracy before,
for instance:

Digits:=40;

In the algebraic case just rho is returned. The output is facilitated by the usage of several
abbreviations (4.23, 4.24, 4.25, 4.26) for certain one-loop contributions which are intro-
duced in detail in the context of the OneLoop procedure in sect. 4.3.3. The abbreviations
are substituted if the evalRex command is used (cf. sect. 4.3.3).

4.2.11 Special relations

If external momenta are zero or parallel, xloops omits those Lorentz vectors which are
no longer independent and therefore redundant. The number of form factors – and the
dimension of the parallel space – may decrease. If this is the case the form factors will no
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longer be expressed in terms of proper OneloopnPt and TwoloopnPtm functions, but with
the help of its variants Oneloopk_nPt and Twoloopk_nPtm which are reduced in dimension
of parallel space. The Oneloopk_nPt functions correspond to the OneLoopk_nPt functions
from sect. 4.3.

If for instance in the case of the two-point function the external momentum q1 shall
vanish, one has to make the following assignment before starting the calculation:

q10:=0;

Now the bosonic self-energy reduces to

[C1 = term1 , C1 G(nu1,nu2)]

which means that one form factor vanished. The only remaining form factor is expressed by
a Oneloop1_2Pt function – this is a two-point function with a parallel space of dimension
zero. The notation “1_2Pt” reflects the fact that this function carries properties of the
two-point function as well as of the one-point function.

If in the case of a three-point function both external momenta q1 and q2 have a com-
mon rest frame one has to make the assignment

q21:=0;

Now the momentum q2 will disappear from the equation which defines the form fac-
tors since it is no longer independent of q1 (“zero recoil limit”). In addition the proper
Oneloop3Pt will switch to Oneloop2_3Pt functions – a mixing of two- and three-point
functions.

It is important here to make the assignment first and then to evaluate the diagram,
because otherwise number and shape of form factors may be wrong. Moreover, if special
relations exist which fix the variables of the EvalGraph functions or connect them with
each other – like for instance the on-shell condition which connects masses and momenta
– it is important first to declare these relations and then evaluate the functions.

Otherwise, if the functions are evaluated first analytically and then numbers or re-
lations between variables are substituted in the result, Maple has to do more work than
necessary. Moreover, it might happen in some special cases that an error occurs – some-
thing like “division by 0”. Usually this sort of divergence is artificial and not an error
xloops is responsible for – at the moment of calculation the parameters which cause the
error message were general analytical expressions. The problem can be overcome in ei-
ther expanding in the critical parameters before the insertion of values, or – and this is
recommended here – in calling the diagram window or the EvalGraph routines with the
final values for the arguments from the very beginning, because the program was taught
to detect a lot of this critical points and to avoid such artificial infinities in the result.

4.2.12 Fast evaluation

If the entry Oneloop Library of the Options menu is selected or – within an ordinary Maple
session – the variable LibPath is assigned with some path, the procedures assume that
a library of OneLoop functions is stored in the assigned directory – as described in sect.
4.5. The necessary integrals are then read from this directory – which of course is much
faster (see sect. B.3). Otherwise, if LibPath is not assigned, the procedures are forced to
recalculate the necessary OneLoop functions at any occurrence.
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4.3 The OneLoop procedures

4.3.1 Input

There exist nine basic functions for the calculation of one-loop integrals. The first three
functions

⊲ OneLoop1Pt(p,m, t)

⊲ OneLoop2Pt(p0, p⊥, q10,m1,m2, t1, t2)

⊲ OneLoop3Pt(p0, p1, p⊥, q10, q20, q21,m1,m2,m3, t1, t2, t3)

correspond to the notation in parallel and orthogonal space variables. The next three
functions

⊲ OneLoop1_2Pt(p,m1,m2, t1, t2)

⊲ OneLoop1_3Pt(p,m1,m2,m3, t1, t2, t3)

⊲ OneLoop2_3Pt(p0, p⊥, q10, q20,m1,m2,m3, t1, t2, t3)

are used in the case of reduced parallel space. All abovementioned functions require the
tensor degree, the external momenta qn and the masses mn as input. The powers tn of
the propagator terms in the denominator are optional. The remaining three functions

⊲ OneLoopTens1Pt(i,m, t)

⊲ OneLoopTens2Pt(i,q1
2,m1,m2, t1, t2)

⊲ OneLoopTens3Pt(i,q1
2,q2

2, (q2 − q1)2,m1,m2,m3, t1, t2, t3)

require the squared external momenta as input variables and return the complete rank-i
tensor. The powers tn of the propagator terms in the denominator again are optional.

4.3.2 Notation

In detail the basic functions directly correspond to the following integrals:

⊲ One-point function:

lm

OneLoop1Pt(p,m, t) = A(p)(t)(m) =

∫

dDl
(l2)

p

2

[l2 − m2 + i̺]t
(4.5)

OneLoop1Pt(p,m) = OneLoop1Pt(p,m, 1) (4.6)

OneLoopTens1Pt(i,m, t) = A
(t)
µ1···µi

(m) =

∫

dDl
lµ1

· · · lµi

[l2 − m2 + i̺]t
(4.7)

OneLoopTens1Pt(i,m) = OneLoopTens1Pt(i,m, 1) . (4.8)
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⊲ Two-point function:

m1

m2

l + q1

l

q1 q1

OneLoop2Pt(p0, p⊥, q10,m1,m2, t1, t2) = B(p0p⊥)(t1t2)(q10,m1,m2)

=

∫

dDl
(l0)

p0 (l⊥)p⊥

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2
(4.9)

OneLoop2Pt(p0, p⊥, q10,m1,m2) = OneLoop2Pt(p0, p⊥, q10,m1,m2, 1, 1) (4.10)

OneLoop1_2Pt(p,m1,m2, t1, t2)

=

∫

dDl
(l2)

p

2

[l2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2
(4.11)

OneLoop1_2Pt(p,m1,m2) = OneLoop1_2Pt(p,m1,m2, 1, 1) (4.12)

OneLoopTens2Pt(i,q1
2,m1,m2, t1, t2) = B

(t1,t2)
µ1···µi

(q1
2,m1,m2)

=

∫

dDl
lµ1

· · · lµi

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2
(4.13)

OneLoopTens2Pt(i,q1
2,m1,m2) = OneLoopTens2Pt(i,q1

2,m1,m2, 1, 1) . (4.14)

Abbreviations:

q10 =

√

q1
2 ; l0 =

l · q1
√

q1
2

; l⊥ =
√

l20 − l2 . (4.15)

⊲ Three-point function:

l + q1

l + q2

l

m1

m2

m3q1

q2

q2 − q1

OneLoop3Pt(p0, p1, p⊥, q10, q20, q21,m1,m2,m3, t1, t2, t3)

= C(p0p1p⊥)(t1,t2,t3)(q10, q20, q21,m1,m2,m3) (4.16)

=

∫

dDl
(l0)

p0 (l1)
p1 (l⊥)p⊥

[(l + q1)2 − m2
1 + i̺]t1 [(l + q2)2 − m2

2 + i̺]t2 [l2 − m2
3 + i̺]t3
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OneLoop3Pt(p0, p1, p⊥, q10, q20, q21,m1,m2,m3)

= OneLoop3Pt(p0, p1, p⊥, q10, q20, q21,m1,m2,m3, 1, 1, 1) (4.17)

OneLoop2_3Pt(p0, p⊥, q10, q20,m1,m2,m3, t1, t2, t3)

=

∫

dDl
(l0)

p0 (l⊥)p⊥

[(l + q1)2 − m2
1 + i̺]t1 [(l + q2)2 − m2

2 + i̺]t2 [l2 − m2
3 + i̺]t3

OneLoop2_3Pt(p0, p⊥, q10, q20,m1,m2,m3)

= OneLoop2_3Pt(p0, p⊥, q10, q20,m1,m2,m3, 1, 1, 1) (4.18)

OneLoop1_3Pt(p,m1,m2,m3, t1, t2, t3)

=

∫

dDl
(l2)

p

2

[l2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2 [l2 − m2
3 + i̺]t3

OneLoop1_3Pt(p,m1,m2,m3) = OneLoop1_3Pt(p,m1,m2,m3, 1, 1, 1) (4.19)

OneLoopTens3Pt(i,q1
2,q2

2, (q2 − q1)2,m1,m2,m3, t1, t2, t3)

= C
(t1,t2,t3)
µ1···µi

(q1
2,q2

2, (q2 − q1)2,m1,m2,m3) (4.20)

=

∫

dDl
lµ1

· · · lµi

[(l + q1)2 − m2
1 + i̺]t1 [(l + q2)2 − m2

2 + i̺]t2 [l2 − m2
3 + i̺]t3

OneLoopTens3Pt(i,q1
2,q2

2, (q2 − q1)2,m1,m2,m3)

= OneLoopTens3Pt(i,q1
2,q2

2, (q2 − q1)2,m1,m2,m3, 1, 1, 1) . (4.21)

Abbreviations – using the auxiliary property (4.2):

q10 =

√

q1
2 ; q20 =

q1 · q2
√

q1
2

; q21 =

√

(q1 · q2)2

q1
2 − q2

2 ;

l0 =
l · q1
√

q1
2

; l1 = − l · q̂2
√

−q̂2
2

; l⊥ =
√

l20 − l21 − l2 .

(4.22)

Our notation for the OneLoopnPt functions distinguishes between parallel and orthog-
onal space which is reflected by the definitions of (4.15) and (4.22) for the momentum
components. Please keep in mind the fact that in our notation the indices p0, p1, . . . rep-
resent the powers of the different components of the loop momentum l which should not
be mixed with Lorentz indices µ1, µ2, . . . of the corresponding tensor OneLoopTensnPt.

If the powers tn of the propagator terms in the denominator are omitted like in (4.6,
4.8, 4.10, 4.14, 4.17, 4.21) the program assumes the value 1 for each tn.

4.3.3 Output of OneLoopnPt

The results of the OneLoopnPt functions are Laurent expansions in terms of the ultraviolet
regulator ε. Therefore the output of the OneLoopnPt procedures consists of a list where
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the significant coefficients – O(ε−1), O(ε0) – of this expansion are denoted. In two-loop
calculations the term of O(ε1) of the one-loop functions is also of interest. For that purpose
this coefficient is also calculated if the qualifier more is used in the function call:

Eingabe Ausgabe

OneLoop1Pt(p,m, t) [ε−1-term, ε0-term]

OneLoop1Pt(p,m, t, more) [ε−1-term, ε0-term, ε1-term]

OneLoop1_2Pt(p,m1,m2, t1, t2) [ε−1-term, ε0-term]

OneLoop1_2Pt(p,m1,m2, t1, t2, more) [ε−1-term, ε0-term, ε1-term]

OneLoop2Pt(p0, p⊥, q10,m1,m2, t1, t2) [ε−1-term, ε0-term]

OneLoop2Pt(p0, p⊥, q10,m1,m2, t1, t2, more) [ε−1-term, ε0-term, ε1-term]

OneLoop1_3Pt(p,m1,m2,m3, t1, t2, t3) [ε−1-term, ε0-term]

OneLoop1_3Pt(p,m1,m2,m3, t1, t2, t3, more) [ε−1-term, ε0-term, ε1-term]

OneLoop2_3Pt(p0, p⊥, q10, q20,m1,m2,m3, t1, t2, t3) [ε−1-term, ε0-term]

OneLoop2_3Pt(p0, p⊥, q10, q20,m1,m2,m3, t1, t2, t3, more) [ε−1-term, ε0-term, ε1-term]

OneLoop3Pt(p0, p1, p⊥, q10, q20, q21,m1,m2,m3, t1, t2, t3) [ε−1-term, ε0-term]

OneLoop3Pt(p0, p1, p⊥, q10, q20, q21,
m1,m2,m3, t1, t2, t3, more) [ε−1-term, ε0-term, ε1-term]

In the output ε−1-term is meant to represent the divergent part (the coefficient of 1
ε
)

whereas ε0-term is describing the finite part and ε1-term the O(ε) contribution.

As long as the arguments of the OneLoop functions are symbols the output is given
algebraically, whereas of course numbers inserted for the arguments imply a numerical
result. Like in the case of the EvalGraph routines, in numerical evaluations the program
sets the value of ̺, the imaginary part of the propagators, five digits higher than the
numerical accuracy of the whole calculation, for example to 10−15 if one calculates with
20 digits. In the algebraic case just rho is returned. To get a compact result also in algebraic
calculations, the output is written by using several abbreviations:

R2ex1(x, y) =

√

1 − x

y

[

ln

(

1 −
√

1 − x

y

)

− ln

(

1 +

√

1 − x

y

)

+ iπ

]

(4.23)

− ln(−x) − iπ

R2ex2(x, y) =

(

1 +

√

1 − x

y

)

Li2



1 −
1 −

√

1 − x
y

1 +
√

1 − x
y





+

(

1 +

√

1 − x

y

) [

ln

(

1 −
√

1 − x

y

)]2

+

(

1 −
√

1 − x

y

)

Li2



1 −
1 +

√

1 − x
y

1 −
√

1 − x
y





+

(

1 −
√

1 − x

y

) [

ln

(

1 +

√

1 − x

y

)]2

(4.24)

+
1

2
(ln y)2 + 2 (ln x)2 − 2 ln x ln y
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+ (ln y − 2 ln x)

[(

1 +

√

1 − x

y

)

ln

(

1 −
√

1 − x

y

)

+

(

1 −
√

1 − x

y

)

ln

(

1 +

√

1 − x

y

)]

− iπ

√
x − y√−y

[2 ln 2 + ln(x − y)]

R3ex2(x, y, z) = 2 ln
(

1 − x

z

)

η(x, z) + 2 ln
(

1 − y

z

)

η(y, z) (4.25)

+2Li2

(

1 − x

z

)

+ 2Li2

(

1 − y

z

)

+ 2 (ln z)2

R3ex3(x, y, z) = 4S12

(

1 − x

z

)

− 4Li3

(

1 − x

z

)

+ 4S12

(

1 − y

z

)

− 4Li3

(

1 − y

z

)

− 4 η

(

x,
1

z

){

Li2

(x

z

)

+ ln
(

1 − x

z

)

ln
(

− x

z

)

+
1

2

[

ln
(

1 − x

z

)]2
}

− 4 η

(

y,
1

z

){

Li2

(y

z

)

+ ln
(

1 − y

z

)

ln
(

− y

z

)

+
1

2

[

ln
(

1 − y

z

)]2
}

− 4 ln z
[

Li2

(

1 − x

z

)

+ Li2

(

1 − y

z

)]

− 4 ln z

[

η

(

x,
1

z

)

ln
(

1 − x

z

)

+ η

(

y,
1

z

)

ln
(

1 − y

z

)]

+2Li3

(
z − y

z − x

)

− 2Li3

(
(z − y)x

(z − x)y

)

+ 2Li3

(
x

y

)

(4.26)

+

[

ln

(
z − y

z − x

)]2

η

(
y − x

z
,

z

z − x

)

+ 2 η

(

y − x,
1

z

)

×
{

1

2

[

ln

(
z − y

z − x

)]2

− ln

(

− z − y

z − x

)

η

(
z − y

z
,

z

z − x

)}

+2 (ln x − ln y)

[

Li2

(
(z − y)x

(z − x)y

)

− Li2

(
x

y

)]

− ln
(

1 − x

z

)

(ln x − ln y)2 − 2 ζ(3) − 4

3
(ln z)3

+2

[

lnx − ln y − 1

2
ln

(
(z − y)x

(z − x)y

)]

ln

(
(z − y)x

(z − x)y

)

η

(
y − x

y
,

z

z − x

)

.

These functions are related to the corresponding R functions3 [18,19]. They represent the
coefficients of the Taylor expansion in ε making use of (cf. [20])

ζ(n) =

∞∑

k=1

1

kn

Li2(z) = −
z∫

0

ln(1 − s)

s
ds

Li3(z) =

z∫

0

Li2(s)

s
ds

3The function R3ex3(x, y, z) assumes that x and y have an imaginary part of different sign which is
always the case.
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S12(z) =
1

2

z∫

0

ln2(1 − s)

s
ds

η(a, b) = 2πi [θ(− Ima)θ(− Im b)θ(Im(ab)) − θ(Ima)θ(Im b)θ(− Im(ab))] .

The function

evalRex(〈expression〉);

substitutes the Rnexm functions in 〈expression〉 by the corresponding Polylogarithms.

4.3.4 Output of OneLoopTensnPt

The functions OneLoopTensnPt return a full tensor as output.

The output format looks similar to that of the EvalGraph routines. The following
types of arguments – here only demonstrated for the two-point case – are allowed for all
OneLoopTensnPt functions:

⊲ OneLoopTens2Pt(i):
The rank i tensor decomposition of the two-point function is given. The procedure
returns a list consisting in the different coefficients, which are expressed in terms of
the OneLoopnPt tensor integrals, and the defining equation for the coefficients, for
instance in the case i = 2:

[

C21 = − OneLoop2Pt(0, 2)

3 − 2ε
, C20 = − OneLoop2Pt(0, 2)

q2 (−3 + 2ε)

+
OneLoop2Pt(2, 0)

q2
, C20 q1(nu1) q1(nu2)+ C21 G(nu1,nu2)

]

.

⊲ OneLoopTens2Pt(i, full):
The function inserts the results of the OneLoopnPt tensor integrals explicitly. Here
again the case i = 2:

[
C21 = [ε−1-term, ε0-term] , C20 = [ε−1-term, ε0-term] ,

C20 q1(nu1) q1(nu2)+ C21 G(nu1,nu2)
]

.

⊲ OneLoopTens2Pt(i,q1
2,m1,m2, t1, t2):

The function returns the same as OneLoopTens2Pt(i, full), but expressed in the
user-defined terms for q1

2,m1 and m2. Of course numerical values are also allowed.
t1 and t2 are optional.

⊲ OneLoopTens2Pt(i,q1
2,m1,m2, t1, t2, more):

The function returns also the O(ε) contribution. Again, t1 and t2 are optional:

[
C21 = [ε−1-term, ε0-term, ε1-term] , C20 = [ε−1-term, ε0-term, ε1-term] ,

C20 q1(nu1) q1(nu2)+ C21 G(nu1,nu2)
]

.

The C20, C21, . . . correspond to the coefficients of the Passarino-Veltman procedure.
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4.3.5 Infrared divergences

The program is regulating the infrared divergence of the three-point function as well –
which may occur for instance if the momenta are on-shell and one mass is set to 0. There is
no distinction made between UV and IR divergences – that means that there is no infrared
dimension parameter εIR. Both kinds of divergences are described by ε = (4 − D)/2.

4.3.6 Special relations

If special relations exist which fix the variables of the OneLoop functions or connect them
with each other – like for instance the on-shell condition – it is important first to declare
these relations and then to call the functions – as already stressed in the case of the
EvalGraph routines.

If the functions are evaluated first analytically and then numbers or relations between
variables are substituted in the result, it might happen in some special cases that an error
occurs – something like “division by 0”. Usually this sort of divergences is artifical due
to the way the analytical result was written before the insertion (cf. sect. 4.2.11).

4.4 The TwoLoop procedures

4.4.1 Input

Unlike for the one-loop functions on the two-loop level for each n-point case exist different
types of integrals – which correspond to different topologies with the same number of
external legs. To distinguish between the different n-point functions with the same n the
TwoLoop procedures acquire an additional identification number:

⊲ TwoLoop2Pt1(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4,m5, t1, t2, t3, t4, t5)
...

⊲ TwoLoop2Pt8(p0, p⊥, r0, r⊥, s, q10,m1,m2, t1, t2)

⊲ TwoLoopTens2Pt1(i1, i2,q1
2,m1,m2,m3,m4,m5, t1, t2, t3, t4, t5)

...

⊲ TwoLoopTens2Pt8(i1, i2,q1
2,m1,m2, t1, t2).

Like in the one-loop case each function needs the tensor degree, the external momenta qn

and the masses mn as input. The powers tn are again optional.
The functions TwoLoopTensnPtm require the squared external momenta as input vari-

ables and return the complete tensor, whereas the functions OneLoopnPtm correspond to
the notation in parallel and orthogonal space variables.
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4.4.2 Notation

The functions correspond to the following integrals:

⊲ Two-point functions:

Topology 1:

q1 q1

k

l + q1

ll
l + k

m1

m2m3

m4

m5

TwoLoop2Pt1(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4,m5, t1, t2, t3, t4, t5)

=

∫

dDl

∫

dDk
(l0)

p0 (l⊥)p⊥ (k0)
r0 (k⊥)r⊥ (z)s

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2 [l2 − m2
3 + i̺]t3

(4.27)

× 1

[(l + k)2 − m2
4 + i̺]t4 [k2 − m2

5 + i̺]t5

TwoLoopTens2Pt1(i1, i2,q1
2,m1,m2,m3,m4,m5, t1, t2, t3, t4, t5)

=

∫

dDl

∫

dDk
lµ1

· · · lµi1
kν1

· · · kνi2

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2 [l2 − m2
3 + i̺]t3

(4.28)

× 1

[(l + k)2 − m2
4 + i̺]t4 [k2 − m2

5 + i̺]t5
.

Topology 2:

q1 q1

k − q1

kl

l + q1

l + k

m1

m2

m3

m4

m5

TwoLoop2Pt2(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4,m5, t1, t2, t3, t4, t5) (4.29)

=

∫

dDl

∫

dDk
(l0)

p0 (l⊥)p⊥ (k0)
r0 (k⊥)r⊥ (z)s

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2 [(l + k)2 − m2
3 + i̺]t3

× 1

[(k − q1)2 − m2
4 + i̺]t4 [k2 − m2

5 + i̺]t5
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TwoLoopTens2Pt2(i1, i2,q1
2,m1,m2,m3,m4,m5, t1, t2, t3, t4, t5) (4.30)

=

∫

dDl

∫

dDk
lµ1

· · · lµi1
kν1

· · · kνi2

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2 [(l + k)2 − m2
3 + i̺]t3

× 1

[(k − q1)2 − m2
4 + i̺]t4 [k2 − m2

5 + i̺]t5
.

Topology 3:

q1 q1

l

l + q1

k

l + k

m1

m2m3

m4

TwoLoop2Pt3(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4, t1, t2, t3, t4)

=

∫

dDl

∫

dDk
(l0)

p0 (l⊥)p⊥ (k0)
r0 (k⊥)r⊥ (z)s

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2
(4.31)

× 1

[(l + k)2 − m2
3 + i̺]t3 [k2 − m2

4 + i̺]t4

TwoLoopTens2Pt3(i1, i2,q1
2,m1,m2,m3,m4, t1, t2, t3, t4)

=

∫

dDl

∫

dDk
lµ1

· · · lµi1
kν1

· · · kνi2

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2
(4.32)

× 1

[(l + k)2 − m2
3 + i̺]t3 [k2 − m2

4 + i̺]t4
.

Topology 4:

q1 q1

l + q1

l + k

k

m1

m2

m3
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TwoLoop2Pt4(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3, t1, t2, t3) (4.33)

=

∫

dDl

∫

dDk
(l0)

p0 (l⊥)p⊥ (k0)
r0 (k⊥)r⊥ (z)s

[(l + q1)2 − m2
1 + i̺]t1 [(l + k)2 − m2

2 + i̺]t2 [k2 − m2
3 + i̺]t3

TwoLoopTens2Pt4(i1, i2,q1
2,m1,m2,m3, t1, t2, t3) (4.34)

=

∫

dDl

∫

dDk
lµ1

· · · lµi1
kν1

· · · kνi2

[(l + q1)2 − m2
1 + i̺]t1 [(l + k)2 − m2

2 + i̺]t2 [k2 − m2
3 + i̺]t3

.

Topology 5:

q1 q1

k

l + q1

l l

m1

m2m3

m4

TwoLoop2Pt5(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4, t1, t2, t3, t4)

=

∫

dDl

∫

dDk
(l0)

p0 (l⊥)p⊥ (k0)
r0 (k⊥)r⊥ (z)s

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2
(4.35)

× 1

[l2 − m2
3 + i̺]t3 [k2 − m2

4 + i̺]t4

TwoLoopTens2Pt5(i1, i2,q1
2,m1,m2,m3,m4, t1, t2, t3, t4)

=

∫

dDl

∫

dDk
lµ1

· · · lµi1
kν1

· · · kνi2

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2
(4.36)

× 1

[l2 − m2
3 + i̺]t3 [k2 − m2

4 + i̺]t4
.

Topology 6:

q1 q1

k

k − q1

l

l + q1

m1

m2

m3

m4
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TwoLoop2Pt6(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4, t1, t2, t3, t4)

=

∫

dDl

∫

dDk
(l0)

p0 (l⊥)p⊥ (k0)
r0 (k⊥)r⊥ (z)s

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2
(4.37)

× 1

[(k − q1)2 − m2
3 + i̺]t3 [k2 − m2

4 + i̺]t4

TwoLoopTens2Pt6(i1, i2,q1
2,m1,m2,m3,m4, t1, t2, t3, t4)

=

∫

dDl

∫

dDk
lµ1

· · · lµi1
kν1

· · · kνi2

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2
(4.38)

× 1

[(k − q1)2 − m2
3 + i̺]t3 [k2 − m2

4 + i̺]t4
.

Topology 7:

q1

q1

k

l + q1

l

m1

m2

m3

TwoLoop2Pt7(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3, t1, t2, t3) (4.39)

=

∫

dDl

∫

dDk
(l0)

p0 (l⊥)p⊥ (k0)
r0 (k⊥)r⊥ (z)s

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2 [k2 − m2
3 + i̺]t3

TwoLoopTens2Pt7(i1, i2,q1
2,m1,m2,m3, t1, t2, t3) (4.40)

=

∫

dDl

∫

dDk
lµ1

· · · lµi1
kν1

· · · kνi2

[(l + q1)2 − m2
1 + i̺]t1 [l2 − m2

2 + i̺]t2 [k2 − m2
3 + i̺]t3

.
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Topology 8:

q1 q1

k

l + q1

m1

m2

TwoLoop2Pt8(p0, p⊥, r0, r⊥, s, q10,m1,m2, t1, t2) (4.41)

=

∫

dDl

∫

dDk
(l0)

p0 (l⊥)p⊥ (k0)
r0 (k⊥)r⊥ (z)s

[(l + q1)2 − m2
1 + i̺]t1 [k2 − m2

2 + i̺]t2

TwoLoopTens2Pt8(i1, i2,q1
2,m1,m2, t1, t2) (4.42)

=

∫

dDl

∫

dDk
lµ1

· · · lµi1
kν1

· · · kνi2

[(l + q1)2 − m2
1 + i̺]t1 [k2 − m2

2 + i̺]t2
.

Like in the one-loop case for each function holds

TwoLoop2Ptn(p0, p⊥, r0, r⊥, s, q10,m1, . . . ,mk)

= TwoLoop2Ptn(p0, p⊥, r0, r⊥, s, q10,m1, . . . ,mk, 1, . . . , 1) (4.43)

TwoLoopTens2Ptn(i1, i2,q1
2,m1, . . . ,mk)

= TwoLoopTens2Ptn(i1, i2,q1
2,m1, . . . ,mk, 1, . . . , 1) . (4.44)

This means that if the powers tn of the propagator terms in the denominator are omitted
the program assumes the value 1 for each tn.

The abbreviations (4.15) we made in the one-loop case for parallel and orthogonal
space notation are still valid.

There are several relations between different two-point functions. Some of them we
would like to mention here:

TwoLoop2Pt1(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4,m5)

=
1

m2
3 − m2

2

[TwoLoop2Pt3(p0, p⊥, r0, r⊥, s, q10,m1,m3,m4,m5) (4.45)

−TwoLoop2Pt3(p0, p⊥, r0, r⊥, s, q10,m1,m2,m4,m5)]

TwoLoop2Pt5(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4)

=
1

m2
3 − m2

2

[TwoLoop2Pt7(p0, p⊥, r0, r⊥, s, q10,m1,m3,m4) (4.46)

−TwoLoop2Pt7(p0, p⊥, r0, r⊥, s, q10,m1,m2,m4)] .
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Both relations are only valid for m2 6= m3, otherwise one has

TwoLoop2Pt1(p0, p⊥, r0, r⊥, s, q10,m1,m2,m2,m4,m5, t1, t2, t3, t4, t5)

= TwoLoop2Pt3(p0, p⊥, r0, r⊥, s, q10,m1,m2,m4,m5, t1, t2 + t3, t4, t5) (4.47)

TwoLoop2Pt5(p0, p⊥, r0, r⊥, s, q10,m1,m2,m2,m4, t1, t2, t3, t4)

= TwoLoop2Pt7(p0, p⊥, r0, r⊥, s, q10,m1,m2,m4, t1, t2 + t3, t4) . (4.48)

The two-point functions numbered with 1-4 are nonfactorizable whereas the functions 5-8
are products of one-loop integrals, for instance

TwoLoop2Pt6(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3,m4, t1, t2, t3, t4) (4.49)

=







(1
2 , s

2)

(D−1
2 , s

2)
OneLoop2Pt(p0, p⊥, q10,m1,m2, t1, t2)

× OneLoop2Pt(r0, r⊥,−q10,m3,m4, t3, t4) if s even

0 if s odd

TwoLoop2Pt7(p0, p⊥, r0, r⊥, s, q10,m1,m2,m3, t1, t2, t3) (4.50)

=







(1
2 , s

2)

(D−1
2 , s

2)
(−1)

r
⊥

2

(D − 1) · · · (D − 3 + r⊥)

D · · · (D − 2 + r0 + r⊥)

r0!

( r0

2 )!2
r0
2

× OneLoop2Pt(p0, p⊥, q10,m1,m2, t1, t2)

× OneLoop1Pt(r0 + r⊥,m3, t3) if s, r0, r⊥ even

0 else .

4.4.3 Output of TwoLoopnPtm

The output – like in the one-loop case – is a list which contains the relevant coefficients of
the Laurent expansion in ε. Ultraviolet divergences at the two-loop level occur as terms
of O(ε−2) and O(ε−1). Therefore the notation of the output starts with two divergent
coefficients.

For the two-point functions 1-4 the finite part cannot be given completely analytically
for all mass cases. Therefore these functions have two entries in the output list which
describe the finite part. The first one is a list itself denoting an integral representation,
the second one gives the analytically calculable terms.

The integral representation is evaluated directly with the help of VEGAS if two argu-
ments are added. Both arguments must be lists which contain each two numbers. These
numbers carry the input information for VEGAS. Within an ordinary Maple session one
has in addition to assign the variable NumPath as described in sect. 4.6.

input output

TwoLoop2Ptm(p0, p⊥, r0, r⊥, s, q10, [ε−2-term, ε−1-term,
m1, . . . ,mk, t1, . . . , tk) numeric, ε0-term]

TwoLoop2Ptm(p0, p⊥, r0, r⊥, s, q10,m1, . . . ,mk, [ε−2-term, ε−1-term,
t1, . . . , tk, [l1, l2], [n1, n2]) [factor, [result, error]], ε0-term]
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numeric describes the integral representation. This list consists of the following entries

[factor, integrand, x=-infinity..infinity, y=-infinity..infinity]

where integrand is the integrand of the integral representation which has to be integrated
over x and y in the interval (−∞,∞). factor is an analytical factor which multiplies the
integral representation.

The variables l1, l2, n1, n2 represent the grids where the integrand is evaluated: first
l1 iterations with l2 points – itmx= l1 and ncall= l2 are passed to VEGAS – and then
n1 iterations with n2 points – this corresponds to itmx= n1 and ncall= n2. Real and
imaginary part are integrated one after the other.

The other entries of the output list have the same behaviour as in the one-loop case:
As long as the arguments of the TwoLoop functions are symbols the output is given al-
gebraically, whereas numbers inserted for the arguments imply a numerical result. In the
numerical case, the program sets the value of ̺, the imaginary part of the propagators,
five digits higher than the numerical accuracy of the whole calculation, for example to
10−15 if one calculates with 20 digits. In the algebraic case just “rho” is returned.

In the case where all internal particles are massless the result is of course known
analytically. In this case numeric is just [0].

The two-point functions 5-8 are products of one-loop integrals and therefore evaluated
completely analytically. The output list has no entry for numerical evaluation and looks
simply like:

input output

TwoLoop2Ptm(p0, p⊥, r0, r⊥, s, q10,
m1, . . . ,mk, t1, . . . , tk) [ε−2-term, ε−1-term, ε0-term]

TwoLoop2Ptm(p0, p⊥, r0, r⊥, s, q10,m1, . . . ,mk,
t1, . . . , tk, [l1, l2], [n1, n2]) [ε−2-term, ε−1-term, ε0-term]

The optional input of two lists for the VEGAS input data doesn’t affect the output since no
numerical integration is performed here. The O(ε1) is not relevant in two-loop calculations.
Therefore the qualifier more does not exist for two-loop functions.

The divergent part of two-loop integrals is closely related to one-loop integrals. There-
fore the same abbreviations (4.23, 4.24) as for one-loop integrals are appearing. They are
substituted if the evalRex command is used (cf. sect. 4.3.3).

4.4.4 Output of TwoLoopTensnPtm

The functions TwoLoopTensnPtm return a full tensor as output. The same types of ar-
guments are allowed as for the corresponding OneLoopTensnPt functions described in
sect. 4.3.4 – except the qualifier more.

4.5 The OneLoopLib procedures

For different calculations of the same OneLoop function it is of course rather inconvenient
to start the whole program again. Therefore our package includes the functions

⊲ OneLoopLib2Pt(i, j)

⊲ OneLoopLib3Pt(i, j)
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which generate a library of all OneLoop2Pt and OneLoop3Pt functions respectively up to
the tensor rank i. All powers of the denominators from 1 to j are considered. The second
parameter j is optional. If it is omitted the procedures assume the value 1 for j, so that
no powers of denominators higher than one are calculated. These functions are then read
by the proper procedures described before, so that they in any case speed up.

If you use the OneLoopLib functions within an ordinary Maple session and want to
write this library in any other than the actual directory you have to assign the variable
LibPath:

LibPath:=〈path〉;

Now the library will be written to 〈path〉. The procedures will only look for the library if
the entry Oneloop Library of the Options menu is selected or if LibPath is assigned. If the
procedures search for an integral which is not contained in the library it will be calculated
and stored in the library on the fly. Each integral corresponds to one file. In appendix B.2
we list the convention for the file names.

4.6 Numerical integration with VEGAS

For numerical integration a parallelized implementation of the VEGAS algorithm for C++

invented by R. Kreckel is provided with xloops. To use the routines within an ordinary
Maple session one has to declare the variable NumPath:

NumPath:=〈path〉;

〈path〉 describes the directory where the integration routines are located. If xloops is in-
stalled properly this is the subdirectory cxx of the xloops directory.

The routines are customized for those TwoLoop procedures which cannot be calculated
analytically. The most elegant way to perform those numerical integrations is described
in sect. 4.2.10 and 4.4.3. In addition there is also the possibility to perform an integration
separately. For that purpose there exists the command

NumIntC(〈integrand〉,[m1,m2],[n1, n2]);

〈integrand〉 denotes the expression which has to be integrated numerically. xloops expects
the integration variables to be named x and y – as they are called by the EvalGraph2 and
TwoLoop procedures. The variables m1,m2, n1, n2 represent the grids where the integrand
is evaluated: first m1 iterations with m2 points – itmx= m1 and ncall= m2 are passed
to VEGAS – and then n1 iterations with n2 points – this corresponds to itmx= n1 and
ncall= n2. Real and imaginary part are integrated one after the other. If only the real
part is of interest one has to specify

NumIntC(〈integrand〉,[m1,m2],[n1, n2],Re);

if only the imaginary part shall be evaluated one writes

NumIntC(〈integrand〉,[m1,m2],[n1, n2],Im);

If NumIntC is called only with the first argument xloops takes the values m1 = 20, m2 =
1000, n1 = 5 and n2 = 10000.
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The output has the following format:

[〈result〉, 〈error〉] .

〈result〉 describes the – possibly complex – numerical result, 〈error〉 is the uncertainty (1σ)
of the numerical integration which is returned by VEGAS.

NumIntC performs the necessary internal steps (
”
compile, link“) and starts the C++

program as subprocess. Maple waits until the subprocess terminates and finally re-reads
the result.

The numerical integration with VEGAS should be used only once by each user. Other-
wise there will occur conflicts because several numerical integrations would use the same
C++ files.

Figure 4.7: Options for VEGAS

The entry Numeric of the Options menu enables the user to change the parameters for
VEGAS. These parameters are set in a window displayed in fig. 4.7.



5 Conclusion and outlook

Our aim was to introduce a program package that gives any computer user the possibility
to calculate particle processes without much effort in manpower and hardware. At this
stage of development the program is still understood to be under construction. In fact we
are planning to incorporate several additional features:

⊲ One-loop four-, five- and six-point functions.

⊲ Two-loop three- and four-point functions.

⊲ Calculation of complete processes, generation of all diagrams which contribute to a
process in a given order.

⊲ Incorporation of other models, for instance supersymmetric theories.

⊲ An interface for adding other models.

⊲ A plotting device for automatical plotting of results.

⊲ Automatical renormalization, determination of Z factors and renormalized functions.
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A Examples

A.1 Installation

A typical run of the configure script looks like the following:

./configure

This is the XLOOPS installation script !

Which Release of Maple V are you using [1/2/3/4] ? 3

Enter the name of the WWW Browser executable,

which XLOOPS should use ! netscape

Do you have Isolatin-1 character encoding [y/n] ? y

If you feel unsure, answer the following question with ’n’.

XLOOPS can work in single processor mode on multi processor machines as well.

Do you have multiprocessing (and POSIX thread library installed) [y/n] ? y

How many processors has your computer ? 2

On which platform are you installing xloops ?

Linux [l] Digital OSF [d] SUN Solaris [s] IBM AIX [a] Other Unix [o] l

Instead of creating the library you can also get a prebuilt library

from the XLOOPS homepage and unpack it.

Shall I create the library of one-loop functions

(takes approx. 1 hour) [y/n] ? n

Now testing for Maple output bug while reading the library !

----------------------------------------------------------------------------

|\^/| Maple V Release 3 (Universitaet Mainz)

._|\| |/|_. Copyright (c) 1981-1994 by Waterloo Maple Software and the

\ MAPLE / University of Waterloo. All rights reserved. Maple and Maple V

<____ ____> are registered trademarks of Waterloo Maple Software.

| Type ? for help.

> read(‘loops.ma‘);

Warning: new definition for &*

»»»»»»»»»»»»»»»»»» This is XLOOPS Version 1.0 «««««««««««««««««««

by Lars Brücher, Johannes Franzkowski, Dirk Kreimer

c©1993-1997 Johannes Gutenberg Universität Mainz, Germany

bytes used=1001220, alloc=851812, time=0.03

bytes used=2011736, alloc=1310480, time=0.03

> LibPath := ‘../lib/‘ ;

LibPath := ../lib/
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> EvalGraph1(3,[higgs,higgs,higgs,higgs,higgs,higgs],full);

bytes used=3011944, alloc=1834672, time=0.03

> quit;

bytes used=3662072, alloc=1834672, time=0.03

----------------------------------------------------------------------------

Did you see any result of the Maple command ’EvalGraph’ used above [y/n] ? n

System configuration completed, doing now some checks !

This may take a while !

Creating the index file for tcl !

Now testing the Makefile for numerical integrations generated for your System !

rm -f main funct.o numint.o div0.o vegas.o gauss.o utils.o

g++ -DGNU_COMPLEX -O3 -fomit-frame-pointer -finline-functions -m486 -malign-

functions=4 -malign-jumps=4 -malign-loops=4 -fexpensive-optimizations -funroll-l

oops -ffast-math -c funct.cxx

g++ -DGNU_COMPLEX -O3 -fomit-frame-pointer -finline-functions -m486 -malign-

functions=4 -malign-jumps=4 -malign-loops=4 -fexpensive-optimizations -funroll-l

oops -ffast-math -c numint.cxx

g++ -DGNU_COMPLEX -O3 -fomit-frame-pointer -finline-functions -m486 -malign-

functions=4 -malign-jumps=4 -malign-loops=4 -fexpensive-optimizations -funroll-l

oops -ffast-math -c div0.cxx

g++ -DGNU_COMPLEX -O3 -fomit-frame-pointer -finline-functions -m486 -malign-fun

ctions=4 -malign-jumps=4 -malign-loops=4 -fexpensive-optimizations -funroll-loop

s -ffast-math -D_REENTRANT -DPVEGAS_POSIX -c vegas.c

g++ -DGNU_COMPLEX -O3 -fomit-frame-pointer -finline-functions -m486 -malign-

functions=4 -malign-jumps=4 -malign-loops=4 -fexpensive-optimizations -funroll-l

oops -ffast-math -c gauss.cxx

g++ -DGNU_COMPLEX -O3 -fomit-frame-pointer -finline-functions -m486 -malign-

functions=4 -malign-jumps=4 -malign-loops=4 -fexpensive-optimizations -funroll-l

oops -ffast-math -c utils.cxx

g++ -o main funct.o numint.o div0.o vegas.o gauss.o utils.o -lm -lpthread mai

n.cxx

Division by 0 Errors will be ignored

Test: 1/0

Initializing SR-sequences with seed 876920052

Input parameters for vegas: ndim= 2 ncall= 968 2 thread(s)

ittot= 1 itmx= 5 22^1 hypercubes

nprn= 0 ALPH= 1.50

mds= 1 nd= 200 npg=2

xl[ 1]= 0 xu[ 1]= 1

xl[ 2]= 0 xu[ 2]= 1

iteration no. 1 : integral = -1.077957e-06 +/- 9.2e-07

all iterations: integral = -1.077957e-06+/- 9.2e-07 chi**2/IT n = 0

iteration no. 2 : integral = 1.703926e-07 +/- 7.1e-07

all iterations: integral = -2.975584e-07+/- 5.6e-07 chi**2/IT n = 1.2

iteration no. 3 : integral = 1.407306e-09 +/- 4.3e-07

all iterations: integral = -1.079265e-07+/- 3.4e-07 chi**2/IT n = 0.67

iteration no. 4 : integral = -6.310369e-08 +/- 4e-07

all iterations: integral = -8.938296e-08+/- 2.6e-07 chi**2/IT n = 0.45

iteration no. 5 : integral = -2.702396e-07 +/- 3.2e-07

all iterations: integral = -1.618004e-07+/- 2e-07 chi**2/IT n = 0.38

Input parameters for vegas: ndim= 2 ncall= 9800 2 thread(s)

ittot= 1 itmx= 3 70^1 hypercubes

nprn= 0 ALPH= 1.50

mds= 1 nd= 200 npg=2
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xl[ 1]= 0 xu[ 1]= 1

xl[ 2]= 0 xu[ 2]= 1

iteration no. 1 : integral = -4.470697e-08 +/- 6.2e-08

all iterations: integral = -4.470697e-08+/- 6.2e-08 chi**2/IT n = 0

iteration no. 2 : integral = 2.028027e-08 +/- 5.3e-08

all iterations: integral = -6.763662e-09+/- 4e-08 chi**2/IT n = 0.63

iteration no. 3 : integral = -2.663549e-08 +/- 5.1e-08

all iterations: integral = -1.435286e-08+/- 3.2e-08 chi**2/IT n = 0.36

Total Number of ignored Divisions by 0: 0

Input parameters for vegas: ndim= 2 ncall= 968 2 thread(s)

ittot= 1 itmx= 5 22^1 hypercubes

nprn= 0 ALPH= 1.50

mds= 1 nd= 200 npg=2

xl[ 1]= 0 xu[ 1]= 1

xl[ 2]= 0 xu[ 2]= 1

iteration no. 1 : integral = 7.704579e-06 +/- 1.3e-06

all iterations: integral = 7.704579e-06+/- 1.3e-06 chi**2/IT n = 0

iteration no. 2 : integral = 8.286222e-06 +/- 6.8e-07

all iterations: integral = 8.160574e-06+/- 6.1e-07 chi**2/IT n = 0.16

iteration no. 3 : integral = 9.681104e-06 +/- 6.2e-07

all iterations: integral = 8.902334e-06+/- 4.3e-07 chi**2/IT n = 1.6

iteration no. 4 : integral = 8.987195e-06 +/- 5e-07

all iterations: integral = 8.938647e-06+/- 3.3e-07 chi**2/IT n = 1.1

iteration no. 5 : integral = 8.732733e-06 +/- 3.7e-07

all iterations: integral = 8.84922e-06+/- 2.5e-07 chi**2/IT n = 0.85

Input parameters for vegas: ndim= 2 ncall= 9800 2 thread(s)

ittot= 1 itmx= 3 70^1 hypercubes

nprn= 0 ALPH= 1.50

mds= 1 nd= 200 npg=2

xl[ 1]= 0 xu[ 1]= 1

xl[ 2]= 0 xu[ 2]= 1

iteration no. 1 : integral = 8.890832e-06 +/- 1e-07

all iterations: integral = 8.890832e-06+/- 1e-07 chi**2/IT n = 0

iteration no. 2 : integral = 8.87138e-06 +/- 5.3e-08

all iterations: integral = 8.875575e-06+/- 4.7e-08 chi**2/IT n = 0.029

iteration no. 3 : integral = 8.798005e-06 +/- 4.7e-08

all iterations: integral = 8.836898e-06+/- 3.4e-08 chi**2/IT n = 0.68

Total Number of ignored Divisions by 0: 0

Make seems to work, so Makefile is correct !

If you had problems please edit the Makefile in the subdirectory ./cxx

until it compiles correctly. Please report your system configuration and

Makefile changes to xloops@thep.physik.uni-mainz.de !

Do you agree sending the XLOOPS team a mail [Y/n] ? Y

XLOOPS installed successfully, invoke with ./xloops !
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A.2 Examples with the Xwindows frontend

To demonstrate the input and output of xloops some typical examples are given. The
Feynman diagrams in this chapter are Postscript pictures produced with xloops.

A.2.1 Output of one-loop integrals

Analytic examples

At first we want to show the different ways of evalu-
ating the diagrams. As an example we have chosen a
simple self-energy diagram. The advantage of this dia-
gram is the relatively short result. The diagram on the
right shows the process, a nondiagonal Z self-energy
with a W bubble.

(q10,0) (q10,0)

W

~Z

With
✄

✂

�

✁
Evaluate the following result is obtained:

G1 := [

2 2 2 2 2 2 2

C1 = 1/16 I e cos(tw) (1 + eps Ln(4 Pi MU ) + 1/2 eps Ln(4 Pi MU ) )

/ 4

(6 I - 4 I eps) Oneloop1Pt(0, Mw) / (sin(tw) Pi ),

/

C1 G(nu1, nu2)]

As expected, the structure of form factors, indicated by the last element of the list above,
is just proportional to gµν . The pre-factor C1 is determined by an equation, which shows
the corresponding Oneloop functions. In this example just Oneloop1Pt(0, Mw) appears.
As pre-factor the coupling e, the Weinberg angle tw and the renormalization parameter
MU occur.

With
✄

✂

�

✁
Eval. Full the OneLoop function can be evaluated further:

GF2 := [

2 2

I e cos(tw) Mw

C1 = [- 3/8 ----------------,

2

sin(tw) Pi

2 2 2 2 2 2

1/16 I (- 6 Ln(4 Pi MU ) Pi Mw + 4 Pi Mw

2 2 2 2

- 6 (- Ln(Mw - I rho) - Ln(Pi) - gamma + 1) Pi Mw ) e cos(tw)

/ 4

/ (sin(tw) Pi ) ],

/

C1 G(nu1, nu2)]
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Now the constant C1 is evaluated to a list, which elements represent the coefficients of the
Laurent series in the dimensional regulator ε = (4 − D)/2. The first element of the list
shows the divergence of the integral, the second element the convergent part.

Additionally the next order in dimensional regularization can be evaluated. Clicking
on

✄

✂

�

✁
Eval. More shows the result:

GM3 := [

2 2 2 2 2 2 2 2 2

I e cos(tw) Mw I (- 6 Ln(4 Pi MU ) Pi Mw + 4 Pi Mw - 6 %1) e cos(tw)

C1 = [- 3/8 ----------------, 1/16 -----------------------------------------------------------,

2 4

sin(tw) Pi sin(tw) Pi

2 2 2 2 2 2

1/16 I e cos(tw) (- 3 Ln(4 Pi MU ) Pi Mw

2 2 2 2 2 2

+ Ln(4 Pi MU ) (4 Pi Mw - 6 %1) - 6 (1/2 Ln(Mw - I rho)

2 2

- (- Ln(Pi) - gamma + 1) Ln(Mw - I rho) + 1/2 Ln(Pi)

2 2 2 2

- (- gamma + 1) Ln(Pi) + 1/12 Pi + 1/2 gamma - gamma + 1) Pi Mw + 4 %1

/ 4

) / (sin(tw) Pi )

/

],

C1 G(nu1, nu2)]

2 2 2

%1 := (- Ln(Mw - I rho) - Ln(Pi) - gamma + 1) Pi Mw

In the above result the list for C1 was just enhanced by an additinal element, the O(ε1).

Numerical examples

In the following subsection we want to show some numerical examples, where different
kinds of form factors occur. The values for couplings and particle masses where inserted
with Insert Particle Properties from the Options menu. The momentum was set to q10:=Mz0;
and the renormalization parameter was chosen to be MU:=1;. All results are given in natural
units ~ = c = 1 and the energy scale GeV.

(q10,0) (q10,0)

t

t

H

H

(a)

(q10,0) (q10,0)

e

gamma

e

e

(b)

(q10,0) (q10,0)

e

e

~

~

(c)
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The results, when evaluated with
✄

✂

�

✁
Eval. Full , read:

(a)

GF4 := [

C1 = [ - 2143.7993127296539430 I,

-15

- .33537943559210349312*10 + 16785.676157258815796 I], C1]

(b)

GF5 := [

C1 = [ - .11869586429575443972*10 I,

-5 -5

.37289405527131873878*10 + .66133100616139736842*10 I],

C2 =

[.052942866215076463492 I, - .16632491956127147989 - .32145019412334161258 I],

C1 (1 &* ONE) + C2 (1 &* Dg0)]

(c)

GF6 := [

C1 =

[ - 6.4357348171046949024 I, 20.218457221868161079 + 34.784995718164094540 I],

C2 = [.00077427320705022066450 I,

- .0024324510191403821401 - .0041849285213475828278 I],

C1 G(nu1, nu2) + C2 q1(nu1) q1(nu2)]

Figure (a) shows a scalar self-energy. So the result just consists of the scalar constant C1.
Like in the previous example C1 is expanded as a series in ε. Figure (b) shows a fermionic
self-energy, which has Dirac structure. So the form factors are the unity matrix ONE and
Dg0. The pre-factors C1 and C2 are again represented as lists of coefficients of the Laurent
series in ε. Finally figure (c) shows a vector boson self-energy. The result is proportional
to the metric tensor G(nu1, nu2) and to the product of the external momenta q1(nu1)

q1(nu2). Again two constants, C1 and C2, are needed.

A.2.2 Two-loop diagrams

Now some two-loop diagrams shall be evaluated numerically. The values are chosen as
in the previous section, if no comment is made. First we want to show some two-loop
diagrams which factorize, starting with a photon self-energy:
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(q10,0) (q10,0)

W

WW

W

~~

GF7 := [C1 = [ - .16744033026458920315 I,

-19

.70833637543010397531*10 + 2.1988161494279602884 I,

-17

- .42232923827218965144*10 - 14.715169445826507291 I],

C2 = [.000020136974316008130172 I,

-23

- .85187071577025180931*10 - .00026443751189864126887 I,

-21

.50790828055269934758*10 + .0017696990248291598135 I],

C1 G(nu1, nu2) + C2 q1(nu1) q1(nu2)]

The typical structure of a photon self-energy,

C1 G(nu1, nu2) + C2 q1(nu1) q1(nu2) ,

can be seen. The difference to the one-loop self-energy (c) is just the fact, that this graph
is more divergent. So the constants C1 and C2 have an additional list entry, the order ε−2.

Next we demonstrate a three-point function. All momenta are on-shell, e.g. q10:=Mz0;
q20:=Mz0/2; q21:=sqrt(Mz0^2-Melec^2); is passed to Maple with Insert Maple Com-
mand.

(q10,0) (q20,q21)

(q10−q20,−q21)

e

~

Z

W

W

e

e

Z

GF8 := [

-35 -25

[C1 = [0, - .82353974706799645789*10 - .64017338869752026115*10 I,
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-8 -9

- .30410069590311173109*10 - .86001332568491139242*10 I],

-34 -25

C2 = [0, .16428685998560205727*10 - .72770813279248241968*10 I,

-7 -8

- .31775075936778308993*10 - .89861644838148378070*10 I],

-27 -27

C3 = [0, .25907616430369099002*10 + .17084563249491568053*10 I,

-10 -10

.50023692425121327568*10 - .38336659269131090697*10 I],

-27 -26

C4 = [0, .56375581291706017052*10 + .83584350815468097846*10 I,

-9 -9

.52269088721608778944*10 - .40057463723369682265*10 I],

-27 -27

C5 = [0, .11444962108462501382*10 - .21574341953884228136*10 I,

-26 -26

- .13104643398124069502*10 + .25219418322926334904*10 I],

-27 -27

C6 = [0, .19581694212974079513*10 - .32129543956635657630*10 I,

-26 -26

- .22477792468575032187*10 + .37675015987648266663*10 I],

-31 -31

C7 = [0, .13476989938404571673*10 + .21449295663578860996*10 I,

-23 -14

.10998568100*10 - .26575450025692144978*10 I],

-31 -31

C8 = [0, - .13476989941451368157*10 - .21449295669672453982*10 I,

-22 -13

- .11492263298*10 + .27768333121127352587*10 I],

-26 -26

C9 = [0, .31582291657035101225*10 - .30101578572250827460*10 I,

-9 -10

.10838466684439346062*10 + .56893589844240048516*10 I],

-36 -26

C10 = [0, - .98315817920409517794*10 - .13705392377889147738*10 I,

-8 -9

.11324969215000662291*10 + .59447352866059701005*10 I],

-27 -26

C11 = [0, .76454675644007305666*10 - .48786422812941166168*10 I,
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-9 -9

.25011846212167898923*10 - .19168329634264528256*10 I],

-26 -25

C12 = [0, - .20628807340956139895*10 - .21423923511009696554*10 I,

-8 -8

.26134544360394034972*10 - .20028731861370353818*10 I],

C1 (1 &* Dg(nu1)) + C2 &*(1, Dg5, Dg(nu1)) + C3 (1 &* Dg0) q2(nu1)

+ C4 &*(1, Dg5, Dg0) q2(nu1) + C5 (1 &* Dg1) q2(nu1)

+ C6 &*(1, Dg5, Dg1) q2(nu1) + C7 (1 &* ONE) q1(nu1)

+ C8 (1 &* Dg5) q1(nu1) + C9 (1 &* Dg0) q1(nu1)

+ C10 &*(1, Dg5, Dg0) q1(nu1) + C11 (1 &* Dg1) q1(nu1)

+ C12 &*(1, Dg5, Dg1) q1(nu1) ]

Of course the result has more form factors as the diagrams evaluated before. The reason
for this is, that as external particles vector bosons as well as fermions occur.
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B.1 File structure

Init

History.tab

Gr1.ma

Grn.ma

...

.xloops

xloops_user

.cxx

<home directory> <process name>

To understand which files xloops uses for loading and saving of processes, it is necessary
to have a short glance on the file structure, which xloops writes into every user’s home
directory. First of all xloops creates the subdirectory xloops_user. In this directory xloops
writes all user-specific data. If the user now starts to input a new process, xloops creates
in xloops_user a new subdirectory, which has the same name as the process. In this
subdirectory xloops writes to basic files: the file Init with all options entered for this process
(e.g. the model), and the file History.tab, where for every diagram a corresponding
number and a particle list is saved. If one graph from this list is calculated, xloops creates
a new file to save the result. The name of this file includes the number of the diagram
in the particle list. If the user now tries to evaluate this graph again, xloops looks for the
corresponding file and reads the result.

B.2 The one-loop library

To avoid multiple evaluation of one-loop integrals xloops can read these integrals from a
pre-built library. This library is produced with by the OneLoopLib procedures and written
to the directory, which is indicated by the variable LibPath. If the Xwindows interface is
used, this variable points to a common directory, where all integrals are saved. Otherwise
the user can set this variable to the directory, where he has his own library stored. If some
integrals in the library are missing, xloops creates them automatically.1

In practice it is necessary to store not only the general mass case of each integral.
Several special cases are also needed. The correspondence is

Bp0p1t1t2n1.1LOOP ⇐⇒ OneLoop2Pt(p0, p1, q,m1,m2, t1, t2)

Cp0p1p2t1t2t3n1n2i1i2i3i4i5i6.1LOOP ⇐⇒
OneLoop3Pt(p0, p1, p2, q1, q20, q21,m1,m2,m3, t1, t2, t3) .

1Currently only supported on Unix platforms.
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The additional numbers n1, n2 and the optional numbers i1, i2, i3, i4, i5, i6 specify the dif-
ferent kinematical arrangements which have to be taken into account. In the following
tables we list the conditions which belong to each case:

Two-point functions:

conditions method of effective
1 2 n1 solution n-point

q = 0 m1 = m2 triv. D 1
— P 1

m1 = 0 — 1 R 2
m2 = 0 2 R 2

q2 + m2
1 − m2

2 = 0 — 3 R 2
q2 − m2

1 + m2
2 = 0 4 R 2

q + m1 + m2 = 0 — 5 R 2
q − m1 + m2 = 0 6 R 2
q + m1 − m2 = 0 — 7 R 2
q − m1 − m2 = 0 8 R 2

Three-point functions:

conditions method of effective
1 2 3 4 n1n2 solution n-point

q21 = 0 q20 = 0 q1 = 0 m1 = m2 = m3 triv. 2 × D 1
m1 = m2 triv. P D 1
m1 = m3 1
m2 = m3 1
— triv. P 1

m2 = m3 q1 + m1 + m3 = 0 11 D R 2
q1 + m1 − m3 = 0 12
q1 − m1 + m3 = 0 13
q1 − m1 − m3 = 0 14
— 10 D 2

q1 = q20 m1 = m2 q1 + m1 + m3 = 0 21 D R 2
q1 + m1 − m3 = 0 22
q1 − m1 + m3 = 0 23
q1 − m1 − m3 = 0 24
— 20 D 2

q20 = 0 — — 40 P 2
q1 = 0 — — 50 P L 2
q1 = q20 — — 60 P 2
(q2

20 − m2
2)q1 − (q2

1 − m2
1)q20 − m2

3(q20 − q1) = 0 70 P 2
— — — 80 P 2

q1 = 0 m1 = m3

√

q2
20 − q2

21 + m1 + m2 = 0 31 L D R 2
√

q2
20 − q2

21 + m1 − m2 = 0 32
√

q2
20 − q2

21 − m1 + m2 = 0 33
√

q2
20 − q2

21 − m1 − m2 = 0 34
— — 30 L D 2

— — — 90 P L 2
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conditions method of effective
1 2 3 4 n1n2 solution n-point

q20 − q1 = q21 q20 = −q21 — — — 3
m3 6= 0 — — C0 S 3

q20 − q1 = −q21 q20 = q21 — — — 3
m3 6= 0 — — D0 S 3

q20 = q21 m2 6= 0 — — E0 S 3

q20 = −q21 m2 6= 0 — — F0 S 3

q2
20 − q2

21 = m2
2 q2

1 = m2
1 m3 = 0 — G0 S 3

(q20 − q1)
2 − q2

21 = m2
1 q2

20 − q2
21 = m2

3 m2 = 0 — H0 S 3

(q20 − q1)
2 − q2

21 = m2
2 q2

1 = m2
3 m1 = 0 — I0 S 3

The table shows in the first columns the conditions to the masses mi and the external
momenta for a special case. Then the number occuring in the name of the file, in which
the special case is saved is given. In the following two columns the method of solving this
integrals and the effective n-point function to solve is given. The abbreviations for the
method of solution have the following meaning:
D Differentiation to the squares of masses.
P Solving by partial fraction decomposition.
R Special case of the R function, either vanishing or equal arguments.
L Solution by Lorentz transformation and

reduction of parallel space.
S Summands vanish in the sum of residua,

e.g. some residua are 0.
For the tensor integrals of the three point function the following additional cases occur:

conditions method of effective
1 2 3 solution n-point

m1 = 0 — — i1 = 4 R 3
m2 = 0 — i1 = 6 R 3

m3 = 0 i1 = 7 R 3
m3 = 0 — i1 = 5 R 3

m2 = 0 — — i1 = 2 R 3
m3 = 0 — i1 = 3 R 3

m3 = 0 — — i1 = 1 R 3

q2
1 − m2

1 + m2
3 = 0 m1 6= 0 — i2 = 1 R 3

q2
1 + m2

1 − m2
3 = 0 i2 = 2 R 3

q2
1 − m2

2 + m2
3 = 0 m2 6= 0 — i3 = 1 R 3

q2
1 + m2

2 − m2
3 = 0 i3 = 2 R 3

q2
20 − m2

2 + m2
3 = 0 m2 6= 0 — i4 = 1 R 3

q2
20 + m2

2 − m2
3 = 0 i4 = 2 R 3

q2
20 − q2

21 − m2
2 + m2

3 = 0 i4 = 3 R 3
q2
20 − q2

21 + m2
2 − m2

3 = 0 i4 = 4 R 3

q2
1 − m2

1 + m2
2 = 0 m1 6= 0 — i5 = 1 R 3

q2
1 + m2

1 − m2
2 = 0 i5 = 2 R 3

(q20 − q1)
2 − m2

1 + m2
2 = 0 i5 = 3 R 3

(q20 − q1)
2 + m2

1 − m2
2 = 0 i5 = 4 R 3

q2
20 − q2

21 − m2
1 + m2

2 = 0 m2 6= 0 — i6 = 1 R 3
q2
20 − q2

21 + m2
1 − m2

2 = 0 i6 = 2 R 3
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To make the notation clearer, we give the following examples:

Bp0p1t1t2.1LOOP OneLoop2Pt(p0, p1, q,m1,m2, t1, t2)
Bp0p1t1t21.1LOOP OneLoop2Pt(p0, p1, q, 0,m2, t1, t2)
Bp0p1t1t22.1LOOP OneLoop2Pt(p0, p1, q,m1, 0, t1, t2)

Bp0p1t1t23.1LOOP OneLoop2Pt(p0, p1,
√

m2
2 − m2

1,m1,m2, t1, t2)

Bp0p1t1t24.1LOOP OneLoop2Pt(p0, p1,
√

m2
1 − m2

2,m1,m2, t1, t2)

Cp0p1p2t1t2t3.1LOOP OneLoop3Pt(p0, p1, p2, q1, q20, q21,m1,m2,m3, t1, t2, t3)
Cp0p1p2t1t2t31.1LOOP OneLoop3Pt(p0, p1, p2, q1, q20, 0,m1,m2,m3, t1, t2, t3)

Cp0p1p2t1t2t32.1LOOP OneLoop3Pt(p0, p1, p2, q1, q20, q21, q1,
√

q2
20 − q2

21, 0, t1, t2, t3)
Cp0p1p2t1t2t33.1LOOP OneLoop3Pt(p0, p1, p2, q1, q20, q1 − q20,m1,m2,m3, t1, t2, t3)
Cp0p1p2t1t2t34.1LOOP OneLoop3Pt(p0, p1, p2, q1, q20,−q20,m1,m2,m3, t1, t2, t3)
Cp0p1p2t1t2t35.1LOOP OneLoop3Pt(p0, p1, p2, q1, q20, q20 − q1,m1,m2,m3, t1, t2, t3)
Cp0p1p2t1t2t36.1LOOP OneLoop3Pt(p0, p1, p2, q1, q20, q20,m1,m2,m3, t1, t2, t3)
Cp0p1p2t1t2t37.1LOOP OneLoop3Pt(p0, p1, p2, q1, 0, 0,m1,m2,m3, t1, t2, t3)
Cp0p1p2t1t2t38.1LOOP OneLoop3Pt(p0, p1, p2, q1, q1, 0,m1,m2,m3, t1, t2, t3)
Cp0p1p2t1t2t39.1LOOP OneLoop3Pt(p0, p1, p2, 0, q20, q21,m1,m2,m3, t1, t2, t3)

B.3 Run time and numerical stability

Typical run times for the different integrals are displayed in the following table. We used
two different systems: (i) a DEC Alpha 8400 workstation (ii) a PC with i586 chip, 32 MB
RAM and 133 MHz frequency running Linux. All systems are working with Maple V.
Without using the library we found the following run times:

DEC Alpha 8400 i586 133MHz

tensor rank numerical algebraical numerical algebraical

One-loop two-point functions

0 0.02 s 0.04 s 0.04 s 0.06 s
1 0.04 s 0.21 s 0.06 s 0.26 s
2 0.07 s 0.28 s 0.07 s 0.48 s
3 0.08 s 0.41 s 0.09 s 0.76 s

One-loop three-point functions

0 2.54 s 1.83 s 4.83 s 3.31 s
1 2.57 s 2.23 s 5.09 s 3.69 s
2 3.01 s 3.62 s 5.67 s 6.14 s
3 3.78 s 4.16 s 7.61 s 34.58s

It should be emphasized that these are the times which are necessary to generate the
functions once and forever using the OneLoopLibnPt routines. If they once are stored in
the LibPath directory they may be read in quickly. With assigned LibPath we get:
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DEC Alpha 8400 i586 133MHz

tensor rank numerical algebraical numerical algebraical

One-loop two-point functions

0 0.34 s 0.03 s 0.08 s 0.02 s
1 0.39 s 0.05 s 0.09 s 0.03 s
2 0.43 s 0.06 s 0.19 s 0.03 s
3 0.47 s 0.06 s 0.20 s 0.04 s

One-loop three-point functions

0 1.30 s 0.09 s 4.77 s 0.47 s
1 1.32 s 0.10 s 4.81 s 0.57 s
2 1.36 s 0.12 s 5.20 s 0.74 s
3 1.88 s 0.45 s 6.72 s 1.71 s

The accuracy and stability of numerical results may suffer from cancellations of large,
approximately equal dilogarithms. Since Maple supports calculations of arbitrary precision,
it is always possible to increase the number of digits to improve accuracy – instead of
Fortran programs which are limited to Fortran’s restricted accuracy.

Usually we calculated with 20 or 40 digits. For all practical purposes our numerical
results were not influenced significantly – only in the last four or five digits – if the number
of digits increased.

B.4 The xloops distribution

The distribution (packed in xloops.tgz) consists of the following files:

README graphen0.tcl graphenp.tcl particles.txt

XLwidget.tcl graphen1.tcl help.tcl xlinit.tcl

configure* graphen2.tcl history.tcl xloops.prototyp

convert.tcl graphen2a.tcl maple.tcl

graphen.tcl graphen2b.tcl model.tcl

MapleVR1:

cfcn.ma make_lib.map numint.ma_unix simple.ma

evalproc.ma mess.isolatin numint.ma_vms test_maple_bug.map

fmrules.ma mess.ma oneloop.ma twoloop.ma

fmuser.ma mess.no_iso pv.ma unvalue.ma

loops.ma numint.ma r.ma values.ma

MapleVR3:

cfcn.ma make_lib.map numint.ma_unix simple.ma

evalproc.ma mess.isolatin numint.ma_vms test_maple_bug.map

fmrules.ma mess.ma oneloop.ma twoloop.ma

fmuser.ma mess.no_iso pv.ma unvalue.ma

loops.ma numint.ma r.ma values.ma

cxx:

div0.cxx gauss.h makehead.solaris numint2.vms*

div0.h incl.cxx makethread.0 nvegas.c

dpc1.in main.cxx makethread.1 pvegas.c

dpc2.in makefile.rest makethread.2 utils.cxx

dpc3.in makefile.vms numint.cxx utils.h

dpc4.in makehead.AIX numint.prototyp vegas.c

funct.cxx makehead.Linux numint1.unix*

funct.h makehead.generic numint1.vms

gauss.cxx makehead.osf numint2.unix*
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lib:

B00110.1loop

manual:

manual.html

xbms:

Hp1l1t0.xbm Hp3l2t9.xbm Hp4l2t9.xbm p3l0t2.xbm p4l2t13.xbm

Hp1l2t0.xbm Hp4l0t0.xbm attention.xbm p3l1t0.xbm p4l2t14.xbm

Hp1l2t1.xbm Hp4l1t0.xbm file.xbm p3l1t1.xbm p4l2t15.xbm

Hp1l2t2.xbm Hp4l1t1.xbm help.xbm p3l1t4.xbm p4l2t16.xbm

Hp2l0t0.xbm Hp4l1t2.xbm insmath.xbm p3l1t5.xbm p4l2t17.xbm

Hp2l1t0.xbm Hp4l2t0.xbm leftarrow.xbm p3l2t0.xbm p4l2t18.xbm

Hp2l1t1.xbm Hp4l2t1.xbm p1l1t0.xbm p3l2t1.xbm p4l2t19.xbm

Hp2l2t0.xbm Hp4l2t10.xbm p1l1t1.xbm p3l2t10.xbm p4l2t2.xbm

Hp2l2t1.xbm Hp4l2t11.xbm p1l2t0.xbm p3l2t11.xbm p4l2t20.xbm

Hp2l2t10.xbm Hp4l2t12.xbm p1l2t1.xbm p3l2t12.xbm p4l2t21.xbm

Hp2l2t11.xbm Hp4l2t13.xbm p1l2t2.xbm p3l2t13.xbm p4l2t22.xbm

Hp2l2t2.xbm Hp4l2t14.xbm p1l2t3.xbm p3l2t2.xbm p4l2t23.xbm

Hp2l2t3.xbm Hp4l2t15.xbm p1proc.xbm p3l2t3.xbm p4l2t24.xbm

Hp2l2t4.xbm Hp4l2t16.xbm p2l0t0.xbm p3l2t4.xbm p4l2t25.xbm

Hp2l2t5.xbm Hp4l2t17.xbm p2l0t1.xbm p3l2t5.xbm p4l2t26.xbm

Hp2l2t6.xbm Hp4l2t18.xbm p2l1t0.xbm p3l2t6.xbm p4l2t27.xbm

Hp2l2t7.xbm Hp4l2t19.xbm p2l1t1.xbm p3l2t7.xbm p4l2t28.xbm

Hp3l0t0.xbm Hp4l2t2.xbm p2l1t2.xbm p3l2t8.xbm p4l2t3.xbm

Hp3l1t0.xbm Hp4l2t20.xbm p2l1t3.xbm p3l2t9.xbm p4l2t4.xbm

Hp3l1t1.xbm Hp4l2t21.xbm p2l2t0.xbm p3proc.xbm p4l2t5.xbm

Hp3l2t0.xbm Hp4l2t22.xbm p2l2t1.xbm p4l0t0.xbm p4l2t6.xbm

Hp3l2t1.xbm Hp4l2t23.xbm p2l2t10.xbm p4l0t3.xbm p4l2t7.xbm

Hp3l2t10.xbm Hp4l2t24.xbm p2l2t11.xbm p4l1t0.xbm p4l2t8.xbm

Hp3l2t11.xbm Hp4l2t25.xbm p2l2t2.xbm p4l1t1.xbm p4l2t9.xbm

Hp3l2t12.xbm Hp4l2t26.xbm p2l2t3.xbm p4l1t2.xbm p4proc.xbm

Hp3l2t13.xbm Hp4l2t27.xbm p2l2t4.xbm p4l1t6.xbm rightarrow.xbm

Hp3l2t2.xbm Hp4l2t28.xbm p2l2t5.xbm p4l1t7.xbm schraff.xbm

Hp3l2t3.xbm Hp4l2t3.xbm p2l2t6.xbm p4l1t8.xbm xloops.gif

Hp3l2t4.xbm Hp4l2t4.xbm p2l2t7.xbm p4l2t0.xbm xloops.xbm

Hp3l2t5.xbm Hp4l2t5.xbm p2l2t8.xbm p4l2t1.xbm

Hp3l2t6.xbm Hp4l2t6.xbm p2l2t9.xbm p4l2t10.xbm

Hp3l2t7.xbm Hp4l2t7.xbm p2proc.xbm p4l2t11.xbm

Hp3l2t8.xbm Hp4l2t8.xbm p3l0t0.xbm p4l2t12.xbm
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